STRAIGHTENING PHOTOS

Chapter 6

Straightening Photos

Most of the time, we're pretty good at keep-
ing the horizon level in photos, but every
now and then we mess up, as in the picture
of a glacier in Figure 6.20. Since iPhoto can
straighten images, it was easy to rotate the
angle by 1.6 degrees to make it straight, as
you can see in Figure 6.21.

To adjust the angle of a photo:

1. Click the Straighten button or press[s]to
display the straighten tool.

2. Drag the slider to the right to rotate the
image clockwise or to the left to rotate
the image counter-clockwise, using the
yellow grid lines as a reference for true
vertical and horizontal.

3. When you're done, click the X button,
press (Esc), or switch to any other editing
feature to save your changes.

v Tips

B The straighten slider actually zooms in
on your photo and crops it slightly to
keep the edges straight.

W You can use the straighten slider to tweak
the angle of a photo up to 10 degrees in
either direction.

W [f10 degrees isn’'t enough (and remem-
ber that the greater the angle, the more
iPhoto is cropping), save your changes,
edit the photo again, and use the
straighten slider one more time.
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Figure 6.20 I’'m going to blame my inability to take a
straight photo of a glacier on the rocking boat.
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Figure 6.21 Luckily, iPhoto's straighten slider lets me
eliminate the need for the lame excuse.
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Enhancing Photos

Traditional photo processors learned long
ago that fiddling with brightness and con-
trast and messing with the colors could turn
a plebeian picture into a luminescent photo.
iPhoto aims to help you do the same for your
photos with its one-click Enhance feature.

To enhance a photo:

1. Inedit mode, click the Enhance button.
Tne yeN\ mn iPhoto adjusts several aspects of your

photo, including color levels, color
saturation, and exposure.

Figure 6.22 The original photo. It’s too dark.

2. Press and release to toggle between
the "before” (Figure 6.22—too dark) and
“after” (Figure 6.23—much better) views
of your photo.

3. Ifyou like what Enhance has done to your
photo, continue working. If not, choose
Undo Enhance Photo ((€md)Z]) from the
Edit menu.

v Tips

B A welcome new feature in iPhoto ‘09 is
Figure 6.23 The photo after clicking Enhance. It’s a that changes mafle by the Enharfce but-
lot better. ton are reflected in the Adjust window, so
you can use Enhance as a starting point
for improving photos further.

2ERIS N EinE

B [n my testing, it appears that Apple has
significantly improved the algorithms
behind the Enhance button, so it does
a better job than in previous versions.

B Use Enhance before any other adjust-
ments, since other changes can result in
Enhance thoroughly mucking up a photo.

B Don't assume Enhance will always
improve your photo. It's usually worth
trying, especially as a starting point for
additional work in the Adjust window,
but only you can decide if its results are
better or worse than the original.
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REDUCING RED-EYE

Chapter 6

Reducing Red-Eye

Perhaps the most annoying thing that can go
wrong in a photograph is red-eye, a red glow
in subjects’ eyes that plagues flash photog-
raphy. Thanks to iPhoto’s face-detection
technology, reducing red-eye is usually easy.

To reduce red-eye in a photo:

1. Click the Red-Eye button or press (] to
open the red-eye tool.

2. Click the Auto button.
This often fixes red-eye accurately, con-
verting the red shades to dark gray. If not,
choose Undo Reduce Red-Eye ([Cmd]Z))
from the Edit menu and continue.

3. Adjust the slider so the mouse pointer’s
size matches the subject’s pupils.

4, Position the circle over each pupil, and
click (Figure 6.24).

5. When you're done, click the X button or
switch to any other editing feature to save
your changes.

v’ Tips

® The Auto button fixes red-eye for all the
faces it can identify in a photo.

B Press and release to toggle between
the “before” and “after” views.

B The Auto button works best when the
subject is facing the camera directly so
iPhoto can identify a face.

W It’s easier to click the subject’s eyes accu-
rately if you zoom in first.

B iPhoto’s technique makes people look as
though they have black eyes, and it won't
work on green-eye in dogs. You may be
able to achieve better results in other
image-editing programs. Also consider
converting the photo to black-and-white.

Figure 6,24 If the
Auto button in the
red-eye tool doesn’t
work, adjust the
slider to match the
mouse pointer’s size
to the size of the
pupil, position the
circle over the pupil,
and click.

What Is Red-Eye?

Red-eye is a phenomenon that occurs

in photographs when light from the
camera’s flash reflects off the blood
vessels in the retina of the subject’s eyes.
It's worse when the flash is close to the
lens, with young children, with blue or
gray eyes (which reflect more light than
darker eyes), and in dim settings.

You can reduce the likelihood of red-eye
occurring in the first place:

¢ Try to cause the subject’s pupils to
contract by increasing the room light,
asking the person to look at a bright
light right before taking the picture,
or using a red-eye reduction feature
in your camera (which pulses the flash
before taking the picture).

¢ Have the subject look slightly away
from the camera lens rather than
directly toward it.

¢ Ifyour camera supports an external
flash unit, use it to increase the
distance between the flash and the
camera lens.
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Retouching Photos

Cindy Crawford’s famous mole notwith-
standing, many otherwise great photos

are marred by small blemishes. Perhaps it’s
a smear of jelly on your toddler’s face, or
someone’s chapped lips. Either way, iPhoto’s
Retouch tool can help.

To retouch a photo:

1. Click the Retouch button or press (1] to
JBo ses mB | open the retouch tool (Figure 6.25).

Figure 6.25 The original photo. Note the jelly smudge 2. Adjust the slider to make the mouse
onthelefeside of Tnstan'slips. pointer a size that's a bit smaller than the

blemish you're trying to remove.

3. Click and scrub over the blemish, using
short strokes (Figure 6.26).
iPhoto blurs the area under the circle
pointer, blending it with the surrounding
colors and textures.

4. Press and release to toggle between
the “before” (Figure 6.25) and “after”
(Figure 6.27) views of your photo.

5. When you're done, click the X button or
switch to any other editing feature to save

Figure 6.26 You can see how I'm drawing over the your Changes.
jelly smudge with the retouch circle. .
v Tips

B For additional accuracy, zoom in first.
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B Retouch is not a panacea. It can fix small
blemishes but will make large ones look
like dust bunnies. It works best on skin.

B Avoid the Retouch tool on sharp color
edges, such as between Tristan’s hands
and his blue shirt. When the Retouch
tool hits edges, it smears the sharp lines.
Luckily, you can always undo mistakes.

B Retouch can be good for taking the flash
shine off eyes or other reflective surfaces.
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Figure 6.27 Much better!
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UsING THE EFFECTS WINDOW

Chapter 6

Using the Effects Window

iPhoto’s Effects window provides single-click

access to a variety of different effects.

To

use the Effects window:

Effect Descriptions

Since the Effects window does a good
job of showing what the result of clicking

1. Click the Effects bL_ltton sl ?ress (e)to its buttons will be, refer to Figure 6.28
open the Effects window (Figure 6.28; on the next page for examples.
next page).
) . . ¢ B & W: Makes the photo black-and-
2. Click a button in the Effects window to white. Click once to apply, again to
apply the associated effect to the current remove ‘
photo (Figure 6.29; next page).
. ¢ Sepia: Makes the photo sepia-toned.
v Tips Click once to apply, again to remove.
B Click the Original button to revert to the ¢ Antique: Desaturates the color in the
original look of the photo; this is a .fast photo and gives it a sepia tint for that
wayto urfdo a number of changes in the old-time look. Click it multiple times
Effects window. to reduce the color saturation and
W For all the buttons other than B & W replace more of the color with sepia.
and Sepia, clicking the button multiple ® Pade Color: Eades the color inthe
times applies the effect again and again. photo, exactly like moving to the
recommend you do this because you can Saturation slider in the Adjust win-
achieve some really interesting results dow to the left. Click it repeatedly to
with multiple applications of an effect. removesllcolon
B iPhoto adds a number at the bottom ® Original: Returns the photo to its
of the button to remind you how many original look with a single click.
times you've clicked, and provides arrows
so you can reduce the number of applica- ¢ Boost Color: Increases the color
tionsof aceffest: saturation in the photo, exactly like
. o moving to the Saturation slider in the
W When you click B & W or Sepia, iPhoto Adjust window to the right. Click it
puts a small ON badge underneath so multiple times to make the photo’s
you know it's on. Click again to remove color truly shocking.
the effect.
‘ _ ‘ ¢ Matte: Applies a white oval mask
B You can combine effects simply by click- around the photo. Click it multiple
ing multiple buttons. For instance, make times to increase the size of the mask,
a photo look old by clicking Antique and obscuring more of the picture.
Vignette a few times.
_ _ _ * Vignette: Exactly like Matte, except
W Edge Blur, combined with cropping, can its mask is black, instead of white.
be a good way to focus attention on the
subject of the photo. ¢ Edge Blur: Exactly like Matte, except
its mask consists of blurred pixels in
the photo, instead of plain white.
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Ee cts

Figure 6.28 To achieve the effects in the photo below, | turned
on Sepia, boosted the color by 1 level, and applied 5 and 6 lev-
els of Matte and Vignette.

, u ﬁ \ 9 \‘ u ﬂ Done = -

Rotate.  Crog Suayhien Evhante  Red-BEye  Aeiouch Efects Audjust

Figure 6.29 You can apply more than one effect at a time, and some of the effects can be applied multiple times to
achieve unusual effects.
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Chapter 6

Using the Adjust Window

The Adjust window enables you to modify
photos in all sorts of useful ways. Although
using the Adjust window can be a fair
amount of effort, it’s usually worth the
results.

To use the Adjust window:

1. Click the Adjust button or press (a] to
open the Adjust window (Figure 6.30).

2. Drag the various sliders until the photo
looks the way you want (see the following
pages in this chapter for details).

3. To apply the same slider settings to
another image, click the Copy button,
switch to the other image, and click
Paste.

v Tips

W Thereis no “right” way to adjust a given
photo other than what looks good to you!

B Pressing to toggle between the
“before” and “after” views shows you the
view before you started working with the
Adjust window, not in between the use of
each individual slider, so it doesn’t help
discern the effect of a given slider.

B [ts difficult to center a slider, so if you
decide you don't like the effect of one, use
Undo ((Cmd]Z)) immediately rather than

trying to reset it to the middle manually.

B Click Reset to reset all the sliders to the
middle.

B Click the X button in the upper left of the
Adjust window to close it, but note that
there’s no need to do so unless you want
to avoid the screen clutter.

Avoid saturating the skin tones

Figure 6.30 Use the sliders in the Adjust window to
modify the exposure, color levels, sharpness, noise
levels, and more.

Color Reproduction

I can't be certain of how the colors in
the example photos in the rest of this
chapter will reproduce onto paper, so

if my comments about what a photo
looks like and how I adjusted it seem off,
rest assured that I'm describing what I
see on my screen! For more details, see
“Understanding Color Management,”
starting on page 206.
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Figure 6.31 The histogram tends toward the left in
dark photos like this one of Halloween pumpkins.

Figure 6.32 In light photos, the histogram moves to
the right, as in this Golden Gate Bridge picture.

Figure 6.33 In this well-balanced photo, the histo-
gram is fairly balanced, neither too far right nor left.

Understanding
the Levels Histogram

Since all the sliders affect the Levels histo-
gram at the top of the Adjust window, it’s
helpful to understand what it’s telling you.

A histogram is a bar chart with each value on
the horizontal axis representing a brightness
value (0 equals black, and 100 equals white)
and the height of each bar representing the
proportionate distribution of pixels with that
brightness value. iPhoto’s Levels histogram
contains three separate graphs, one each for
red, blue, and green. I like to think of them as
mountain ranges.

So, if a picture has a lot of blue in it, the blue
mountain range will probably be large, and
will likely be on the right side (since it's the
brightest color). The red and green mountain
ranges may also be large, but will likely be
further to the left, since they're being used
combinatorially to provide the exact shade
of blue that you see.

The histogram for a too-dark photo will be
pushed over to the left (Figure 6.31) and
one that’s too light will be pushed to the right
(Figure 6.32). In general, a good photo has

a balanced histogram, with roughly equal
areas shown on either side of the midpoint
(Figure 6.33). Balancing the histogram is

a suggestion, not a rule, but keep it in mind
when you're editing.

Every photo’s histogram looks different, and
every change you make to the contents of
the image will change the histogram in some
way, since it’s merely another way of repre-
senting the content of the photo.

As we look at each of the Adjust controls, I'll
explain what each does to the histogram so
you can use them effectively to create bal-
anced, attractive photos.
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ADJUSTING EXPOSURE

Chapter 6

Adjusting Exposure

Exposure is the most fundamental aspect of
photography, since it refers to the amount of
light that strikes the camera’s sensor. Most
cameras control exposure automatically

and do a good job, but they can be fooled or
set wrong, producing an underexposed (too
dark) or overexposed (too light) image. If that
happens, you'll want to use iPhoto’s Exposure
slider and its Levels (next page) sliders.

To adjust the exposure of a photo:

¢ In the Adjust window, drag the Exposure
slider to the left to make it seem as
though less light hit the camera sensor
or to the right to make it seem as though
more light hit the camera sensor.

What the Exposure slider does:

This photo of the waterfall in Figure 6.34
is rather underexposed, thanks to incorrect
camera settings. By increasing the exposure
in Figure 6.35, I've lightened the photo and
brought out more detail.

Increasing exposure generally squishes
the mountain ranges and slides them to
the right, and decreasing exposure makes
them taller and moves them left.

v Tip

B You may be able to achieve slightly better
(or at least different) effects by using the
white point (left) and midtone (center)
Levels sliders, along with the Shadows
slider to boost detail in the darker areas
of the image, as ['ve done in Figure 6.36.

Figure 6.34 This photo, taken with incorrect camera
settings, is rather underexposed, and thus too dark.

Figure 6.35 By increasing the exposure to lighten the
scene, | brought out some of the detail.

Figure 6.36 You can use the Levels controls to do
much of what the Exposure slider does, possibly with
better results.
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Figure 6.37 All the pixels in this image are huddled
together in the middle of the histogram.

Figure 6.38 By redefining the black point, | give the
picture a little more depth and darkness.

Figure 6.39 Then, resetting the white point brings up
the luminosity a bit.

Adjusting Levels

The Levels slider under the histogram gives
you independent controls for adjusting the
black and white points, which define the
pixels that should be considered pure black
and those that should be considered pure
white. Also useful is the midtone control for
adjusting the overall brightness within the
new range.

To adjust the levels of a photo:

¢ Inthe Adjust window, drag the left Levels
slider to the right to set the black point.

* Drag the right Levels slider to the left to
set the white point.

¢ Drag the midtone slider (the center con-
trol) left to lighten the photo or right to
darkenit.

What the Levels sliders do:

If, when you look at a photo's histogram,

you see a blank space between the end of
the mountain ranges and the black or white
points (Figure 6.37), it’s often safe to move
those sliders toward the middle of the his-
togram, which is conceptually the same as
grabbing the edges of the mountain ranges
and pulling them out to the edges of the his-
togram. In Figure 6.38, I've moved the black
point to the right to deepen the shadows;

it's redefining what was a dark gray as total
black. In Figure 6.39, I've moved the white
point to the left to set a new value for what
should be considered white, thus making the
water glow a bit.

Moving the midtone slider moves the entire
mountain range left or right, thus brighten-
ing or darkening the entire image but with-
out going (much) beyond the new black and
white points. Play with it to get a feel for how
it might help your photos.

110

929

S13A37 ONILSNlay



ADJUSTING CONTRAST

Chapter 6

Adjusting Contrast

The contrast of a photo is the difference
between its darkest and lightest areas. With
too much contrast, you end up with overly
dark and bright areas; with too little contrast,
your photo appears flat.

To adjust the contrast of a photo:

¢ Inthe Adjust window, drag the Contrast
slider to the left to decrease the contrast
or the right to increase the contrast.

What the Contrast slider does:

In Figure 6.40, | set the Contrast slider at
zero to show how it makes the reflected trees
indistinct, with little difference between

the light and dark areas. In Figure 6.41,

I've maxed out the contrast to bring out the
blackness of the tree trunks in the white
pond.

Most photos won't need significant contrast
adjustments; usually a little nudge will be all
that’s necessary.

Note how the mountain ranges in the histo-
gram have been flattened and spread out by
the increase in contrast. If I had reduced con-
trast, the mountain ranges would have been
squished in and up instead. Put another way,
increasing contrast distributes the pixels

in the photo over a greater range of bright-
ness values, whereas reducing the contrast
increases the number of pixels within a small
range.

v Tip

B The Contrast slider is a relatively unso-
phisticated tool. You're better off using
the black and white point sliders in the
Levels histogram to set which colors
should be considered pure black and
pure white. Also play with the Definition,
Highlights, and Shadows sliders.

Figure 6.40 With the Contrast slider all the way at
zero, this black-and white photo of trees reflected
in an ice-covered pond becomes flat and indistinct.

Figure 6.41 By increasing the contrast, | made the
black trees stand out significantly more.

What Else Would | Do?

To sharpen the tree trunks and increase
the difference between white and black
even more, I'd bring the black and white
points in, and move the Definition slider
far to the right.
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leaves distracts a bit from Tonya’s face (especially
when the Adjust window is closed).

Figure 6.43 Reducing the color saturation of the
photo causes it to become almost black-and-white,
but that’s not the effect | want either.

Figure 6.44 By protecting skin tones while decreasing
saturation, | focus on Tonya’s face while making the
photo look as though it’s from the 1970s.

Adjusting Saturation

The saturation of a photo is a measure of
how intense the colors are. Highly saturated
colors are said to be deep, vivid, or rich,
whereas desaturated colors (think pastels)
are often thought of as being dull, weak, or
washed out. That's not to say that one is bet-
ter than other; it depends on what you want.

To adjust the saturation of a photo:

+ Inthe Adjust window, drag the Saturation
slider to the left to make the colors
weaker or the right to make them more
intense.

What the Saturation slider does:

In Figure 6.42, Tonya has bright green leaves
in sunshine behind her, and they distract a
bit from her face. So I decreased the color
saturation quite a lot in Figure 6.43. But
since I wanted to decrease the saturation

of only the background, in Figure 6.44 1
sclected the "Avoid saturating the skin tones”
checkbox, which returns Tonya to her origi-
nal color and makes her face stand out.

This checkbox, which is new in iPhoto 09,
is absolutely brilliant, and it lets you use the
Saturation slider in many more situations
than before, when iPhoto would have made

skin overly gray or shockingly ruddy.

When you increase saturation, the mountain
ranges move to the left (the picture gets a
little darker) and they tend to separate, since
each color has more independent brightness
values (the reds are redder, the greens are
greener, and the blues are bluer).

If you decrease saturation, the mountain
ranges move to the right (the picture gets
lighter) and overlap more. Decreasing the
saturation entirely causes the mountain
ranges to overlap entirely, giving you a mono-
chrome image.
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ADJUSTING DEFINITION

Chapter 6

Adjusting Definition

New to iPhoto "09 is the Definition slider,
which helps you bring out details and
increase contrast in automatically selected
portions of a photo. Its effect is often worth-
while, but almost always fairly subtle.

To increase the definition of a photo:

¢ Inthe Adjust window, drag the Definition
slider to the right to increase contrast
and pull out details.

What the Definition slider does:

The photo of milkweed fluff in Figure 6.45
is interesting largely because of the detail

of each individual seed pod. By moving the
Definition to the right, I was able to make
the edges of the hairs more distinct, as in
Figure 6.46. 'm not sure how much of this
you'll be able to see in the print book, but the
effect is definitely noticeable in iPhoto when
[ press and release the Shift key to compare
versions.

What I like about the Definition slider is
that it almost always helps photos that
would benefit from additional detail. The
main place I've found the Definition slider
to be unhelpful is with faces, particularly
close-ups. In that situation, the additional
detail tends to emphasize skin blemishes.
Nonetheless, I encourage you to try the
Definition slider when you're working in
the Adjust window, just to see if it will help.

Moving the Definition slider to the right
slightly flattens and spreads out the histo-
gram’s mountain ranges, but, as you'll see
if you try it, not by a huge amount.

Figure 6.45 This photo of milkweed fluffis a little
fuzzy, but there are details that could be pulled out.

Figure 6.46 Maxing out the Definition slider increases
the detail a bit, without causing any other problems.

What Else Would | Do?

If I wanted to increase detail even further,
[ could increase the sharpness for the
entire photo. Plus, raising the Shadows
slider would bring out more detail in the
darker portion of the photo.
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Figure 6.47 The whitecaps on the ocean waves are
overexposed and washed out in this photo.

Figure 6.48 By dragging the Highlights slider to the
right, | can darken the waves enough so that their
details become visible, all without affecting the rest
of the photo.

What Else Would | Do?

Using the Shadows slider will bring out

a bit more of the detail in Tonya's and
Tristan’s faces, bumping up the Definition
slider adds a bit more contrast in appro-
priate spots, and since this is actually a
cropped portion of a larger photo, using
the Reduce Noise slider smooths out the
red in Tonya’s shirt.

Adjusting Highlight Detail

Adjusting the exposure of a photo lightens
or darkens the entire photo. But when you
have just a portion of the photo that’s over-
exposed, you can use the Highlights slider to
darken just those too-bright spots, increas-
ing the detail in those areas.

To adjust the
highlight detail of a photo:

¢ Inthe Adjust window, drag the Highlights
slider to the right to darken the bright-
est spots while leaving the darker spots
alone.

What the Highlights slider does:

If you look at the ocean waves at the top of
Figure 6.47, you can see that the bright sun-
light caused them to be overexposed. as the
camera tried to keep the exposure correct for
the foreground. By dragging the Highlights
slider to the right, I darkened just the over-
exposed parts, as you can see in Figure 6.48.

Try using the Highlights slider whenever you
have a photo where only parts of it are over-
exposed, or where adjusting the exposure
would mess up dark areas.

When you increase the highlight detail,
you're flattening the higher mountain peaks
at the right (light) end of the histogram while
largely leaving the left (dark) end alone.

114

103

11v13Q LHOITHOIH ONILSnlay



ADJUSTING SHADOW DETAIL

Chapter 6

Adjusting Shadow Detail

Whereas increasing the highlight detail
helps photos that are overexposed in places,
increasing the shadow detail improves
pictures that have too-dark areas mixed with
properly exposed sections. Again, simply
increasing the exposure won't work because
that would blow out the already-light areas.

To adjust the
shadow detail of a photo:

¢ In the Adjust window, drag the Shadows
slider to the right to lighten the too-dark
areas while leaving brighter portions of
the photo alone.

What the Shadows slider does:

The problem with Figure 6.49 is obvious—
the hillside is bathed in shadow, but because
the camera set its exposure based on the
sunlit buildings, the hillside is too dark.

By dragging the Shadows slider to the right

a fair amount, I can throw some more light

on the darker areas of the image, increasing
the detail significantly, as you can see

in Figure 6.50.

The lesson to take away from this is that the
Shadows slider can rescue photos that lose
detail in the dark areas while still having
some bright spots.

When you increase the shadow detail, you're
moving the mountain peaks on the left

(dark) side of the histogram toward the right
(light) side while leaving the right end alone.

Figure 6.49 Because the low sun has been blocked
from the right, the hillside is bathed in deep shadow.

Figure 6.50 By dragging the Shadows slider to the
right, | can increase the exposure on just the shad-
owed hillside, without blowing out the properly
exposed buildings or sky.

What Else Would | Do?

Using the Definition slider would bring
out a bit more detail on the hillside, and
increasing the saturation would make the
green grass and bushes a bit more vivid.
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Figure 6.51 The fine detail in the rusted metal and the
wire suffers a bit from too much blur.

Figure 6.52 Radically increasing the sharpness
brought out the fine edge detail in the rusted metal.

What Else Would | Do?

A small increase in saturation might help
a little, and using the Definition slider
would bring out even more of the texture
in the metal. Raising the Shadows slider
would also reveal a bit more detail in the
darker areas.

Adjusting Sharpness

Many photos are slightly blurry due to
motion of the subject or the camera. You
can use the Sharpen slider to increase the
sharpness—the contrast between adjacent
pixels—and thus sharpen the perceived
focus of the photo (sharpening the actual
focus can be done only with the camera lens,
and it’s too late for that).

To adjust the sharpness of a photo:

¢ Inthe Adjust window, drag the Sharpness
slider to the right to increase the sharp-
ness of the image.

What the Sharpness slider does:

The photo in Figure 6.51 is a picture of an
old, rusted pail next to some rusty wire. I had
good light and managed to hold the camera
still, but there was still a little more fuzzi-
ness than I would have liked. So I increased
the sharpness quite a lot in Figure 6.52, and
I hope you can sce that the result is more
sharply defined edges and textures on the
rusted metal. I find that many photos are
similarly improved by increased sharpness.

It's a little hard to predict exactly what
changes to the sharpness will do to the
histogram’s mountain ranges, but in general,
increasing the sharpness tends to “erode”
them away, making them shorter and wider,
whereas decreasing the sharpness makes
them taller and narrower.

v Tips

B Be careful when increasing the sharpness
on photos that contain a lot of mostly
solid colors, since the increased contrast
between adjacent pixels will make those
previously solid colors appear blotchy.

B In earlier versions of iPhoto. you could
reduce the sharpness of a photo. Use the
Reduce Noise slider for that now.
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Chapter 6

Reducing Noise

Photos taken in low light conditions can
suffer from noise, which most commonly
appears as spots or blotches within areas
of solid color. Since we expect areas of solid
color to be, well, solid, the blotching is quite
off-putting.

To reduce the noise of a photo:

¢ In the Adjust window, drag the Reduce
Noise slider to the right to reduce the
noise and smooth out blotches.

What the Reduce Noise slider does:

Figure 6.53 is a photo of the indoor track

in Barton Hall, at Cornell University. Because
of the high ceilings and poor lighting (for
photography), there is quite a lot of noise

in the solid colored areas of the track, even
though I was able to avoid blur by resting

the camera on a railing in the stands.

With the Reduce Noise slider, I was able to
smooth out the blotches in the red of the
track and the green of the infield, as I hope
you can see in Figure 6.54.

You'll know if you need to use Reduce Noise
by the blotches in large areas of solid color,
but expect it most commonly in pictures
taken in low light conditions.

Reducing the noise in a photo causes the
mountain ranges to adopt a picket fence
look, trading their relatively smooth lines
for a jagged, up-down, up-down display.

i

Figure 6.53 The red of the track and the green of the
infield show quite a bit of noise thanks to the low
light conditions.

Figure 6.54 Reducing the noise with the Reduce
Noise slider blurs the noisy bits to make the end
result smoother. It will be hard to see the difference
in photos that are so heavily reduced.

What Else Would | Do?

The lighting conditions in this photo are
extremely odd, so I would bump up the
shadow detail, and increase saturation

a bit too. Note that I would not use the
Definition slider, since it will make the
solid colors blotchier, as it attempts to
create more detail.

106

117



Editing Photos

Figure 6.55 There’s nothing really wrong with this
photo, but | got the idea that | could make it more
striking by increasing the blue in the sky.

Figure 6.56 Lowering the temperature caused the
slight oranges and pinks from the sunset to be cooled
down with the addition of blue, making for a more
interesting photo.

What Else Would | Do?

About the only thing that would be help-
ful for this photo would be to increase the
saturation a bit to make the remaining
sunset colors in the center pop.

Adjusting Temperature

The temperature of a photo refers to your
perception of which wavelengths of light illu-
minate the scene in a photo. That’s a round-
about way of saying that the Temperature
slider lets you adjust the colors of a photo
from cool (bluish) to warm (yellowish).

To adjust the temperature of a photo:

¢+ Inthe Adjust window, drag the
Temperature slider to the left to make
the colors cooler and bluer or the right
to make them warmer and more yellow.

What the Temperature slider does:

Figure 6.55 is a picture of a sunset, with
plenty of warm pinks and oranges, and while
there’s nothing wrong with the photo, I won-
dered if cooling it down would make it more
interesting, By decreasing the temperature a
lot in Figure 6.56, I've turned the entire sky
a deep blue, making more of a contrast with
the black trees in the foreground.

Although I'm seeing color problems less fre-
quently with modern cameras, it's most likely
that you'll need to adjust the temperature

of artificially lit photos. Indoor lighting may
give a yellow cast whereas flash lighting may
provide a bluish cast.

When you decrease the temperature, as I've
done here, the green mountain range stays
put, the blue mountain range moves to the
right to increase the amount of blue in the
photo, and the red mountain range moves
to the left to decrease the amount of red. If
you increase temperature, the red mountain
range moves to the right to increase the
amount of yellow in the photo, and the blue
mountain range moves to the left to decrease
the amount of blue in the photo.
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Chapter 6

Adjusting Tint

Whereas the Temperature slider helps you
adjust the blue and yellow colors in a photo,
the Tint slider modifies the magenta and
green colors. | seldom need to use either one.

To adjust the tint of a photo:

¢ In the Adjust window, drag the Tint slider
to the left to add magenta to the photo
or to the right to add green.

What the Tint slider does:

Check out Figure 6.57, a picture of my
friend Oliver at his daughter’s birthday party.
The light from the birthday candles causes
the colors to be far too yellow and magenta.
By moving the Tint slider all the way to the
green (right) in Figure 6.58, I've restored the
green to Oliver’s shirt, although pushing the
Temperature slider most of the way to blue
(left) is also necessary to get the colors right.

As you would expect, moving the Tint slider
toward the right moves the green moun-

tain to the right as well, and slides both the
red and blue mountain ranges to the left,
increasing the amount of green and decreas-
ing the amount of magenta (since magenta is
composed of both red and blue). Moving the
Tint slider to the left has the opposite effect.
Also, note that the mountain ranges also
change in size and shape somewhat.

v Tip

B To adjust tint and temperature simul-
taneously by setting the white balance,
click the eyedropper button next to the
Tint slider, and then click on a portion of
the photo that should be white or light
gray (a white shirt, or the white of an eye),
but which is not overexposed. I find this
method of controlling white balance to
be tricky, due to the necessity of finding
some white or light gray.

Figure 6.57 The lack of a flash in this photo means
that all the light comes from the birthday candles,
throwing the colors seriously out of whack.

Figure 6.58 Slamming the Tint slider all the way to
green restores Oliver’s green shirt, but it's also neces-
sary to drop the Temperature slider most of the way
to blue to get the particular hue of green correct.

What Else Would | Do?

Realistically, this just isn't a very good
photo, technically speaking. Increasing
the shadow detail would help, as would
moving the midtone slider most of the
way to the left to lighten it up, but neither
will rescue the photo from the Trash.
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Undoing Changes

We all make mistakes, and that’s certain to
happen on occasion when you're working
with your photos too. With iPhoto, though,

Are you sure you want to revert to the
original version?

All changes will be lost.

(o) @0

Figure 6.59 When you choose Revert to Original,
iPhoto warns you that you'll lose all your changes.

your changes aren't irrevocable.

Ways to undo changes to a photo:

# After you've performed an action, to undo
just that action, choose Undo from the
Edit menu ((Cmd)Z)). Keep choosing Undo
to undo earlier actions.
¢ Toremove all the changes to a photo
in a particular editing session, but not
changes made in a previous session,
choose Revert to Previous from the =
Photos menu or its contextual menu. You E
can also press when editing in the o
main window or in full screen mode. E
Recovering Originals A
¢ Toremove all changes from a photo, x
[t turns out that Revert to Original isn't select it and choose Revert to Original ;
doing anything complicated. When you from the Photos menu or its contextual o
edit a photo, iPhoto makes a copy of the menu. (7]
original in a folder named for the photo’s iPhoto warns that you'll lose all changes
event, stored in the Modified folder. As to the photo, and swaps in the original
long as this happens, you can recover the image (Figure 6.59).
original image no matter what edits you
make to it. ¢ Torevert to the original look of a photo
while working in the Effects window,
In fact, this is why Revert to Original click its Original button.
works even if you edit a photo in another
program—iPhoto starts tracking the ¢ To throw away changes while working in
original as soon as you double-click the the Adjust window, click its Reset button.
photo. However, don’t drag a photo from v Tips
iPhoto to the Dock icon of another pro-
gram to edlt lt, ifyou do S0, IPhOtO Can’t B Youcan l,lI'ldO individual changes made in
track the changes. edit mode only until changes are saved by
o _ clicking Done or moving to the next one.
You can locate an original image in the
Finder by (Control)-clicking it in iPhoto and B To see what the photo would look like if
choosing Show File (to find the original you were to undo a change, press (Shift).
if unedited, or the modified version if it You must still choose Undo if desired.
has been edited) or Show Original File (to B Anything you can undo via the Undo

find the original file if the photo has been
edited).

command, you can redo via the Redo
command in the Edit menu.
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Chapter 6

Using an External Editor

iPhoto’s editing tools are sufficient for most
tasks, but for more-involved changes to pho-
tos, iPhoto lets you turn to another image-
editing program.

To set a default external editor:

1. From the iPhoto menu, choose

Preferences ((Cmd), ]) to open the
Preferences window. If necessary,
click the General button.

2. From the Edit Photos pop-up menu,
choose In Application (Figure 6.60).

3. Inthe Open dialog that appears, choose
the desired program.

To edit in an external editor (I):

1. Ifyou set the Double-Click Photo option
to Edits Photo in the General preference
pane, double-click one or more photos.
iPhoto launches your selected editing
program and opens the photos in it.

2. Make your changes, and when you're
done, save and close the photos.

To edit in an external editor (lI):

1. Set a default external editor, but don't set
iPhoto to open photos in it by default.

2. [Control]-click one or more photos and
choose Edit in External Editor from the
contextual menu (Figure 6.61).

v Tips

W Bevert to Original works on photos edited
in another program as long as you open
them from within iPhoto (dorn t drag them
to the other application to open).

B Use the contextual menu or click the Full
Screen button to avoid opening a photo
in an external editor when that’s the
default option.

Sources: M Show last _IZ_I [;} months album

™ Show item counts

Double-click photo: () Edits photo
) Magnifies photo

In main window

il DT e o R e —

Connecting camera opens:

1 Check for iPhuto updates automatically

Figure 6.60 To configure iPhoto to use another pro-

gram for editing photos, choose In Application from

the Edit Photos pop-up menu in the General pane of
iPhoto’s Preferences window.

[ Cut
Copy

Paste
Cdit
Edit Using Full Screen

Edit In External Editor |

Rotate Clockwise
Rotate Counter Clockwise

Cet Info

Show File

Show Original File

Batch Change. Figure 6.61 To edit a
Dophicets photo in an external editor
My Rating » | without switching iPhoto’s

Make Key Photo
Hide Photo

Move to Trash
Revert to Original

preferences, Control-click

the image and choose Edit
in External Editor from the
contextual menu.
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Reasons to Use
an External Editor

iPhoto, good as it is, lacks some common
editing capabilities because they require
alot of knowledge and skill to use effec-
tively. You might want to look beyond
iPhoto for the following reasons:

¢ Some of iPhoto’s tools, like Red-Eye,
are quite primitive and inflexible.
Other programs have better tools for
fixing red-eye.

¢ Ifyou want to put text on top of an
image in iPhoto, you'll need to use
another image editor.

¢ With the exception of the Retouch
tool, all of iPhoto’s color-correction
and image adjustment tools apply
to the entire image. They may affect
only a portion (such as the Shadows
and Highlights sliders), but you can’t
avoid applying them to the entire
photo. In contrast, other image editing
programs let you select a portion of
the photo before color-correcting it or
otherwise modifying it.

® Other image editing programs include
a bevy of filters and effects that you
can apply to normal photos to turn
them into amazing images that look
like they were painted, embossed,
photocopied, or drawn with charcoal.

¢ Most image editing programs sup-
port layers (imagine a sheet of clear
plastic over the image) and enable you
to make changes on the layer, thus
making it easy to experiment without
hurting the original image.

¢ Once you have layers, it becomes eas-
ier to paint or draw on top of an image,
or to cut out portions of a photo.

External Editors to Try

Although iPhoto’s editing tools have become
more sophisticated over the years, other
applications offer even more capabilities. It's
beyond the scope of this book to talk about
them in any depth. but if you want more
editing power, check out these applications.

Acorn

Flying Meat’s $49.95 Acorn lets you put text
and graphics on top of your photos, apply
sophisticated filters, and more, all with what
may be the simplest interface of any of these
programs. Although Acorn has layer support,
iPhoto can’t import a layered Acorn docu-
ment. www. flyingmeat.com/acorn/

GraphicConverter

Lemkesoft’s GraphicConverter provides
useful tools for adding text to images, work-
ing on non-rectangular selections, apply-
ing filters, and more. The $34.95 app is also
extremely useful if you need to import and
export unusual formats. www. lemkesoft. com

Photoshop Elements

Adobe’s $89.99 Photoshop Elements offers a
subset of the capabilities in Photoshop, with
lots of attention paid to making difficult

tasks (like merging photos and making pan-
oramas) easy. Photoshop Elements can save
layered Photoshop files that iPhoto can use.
www . adobe . com/products/photoshopelmac/

Pixelmator

The $59 Pixelmator, from Pixelmator Team,
is one of the most capable of these apps, with
all the usual features plus a photo browser
that can look into your iPhoto Library, sup-
port for pressure-sensitive graphics tablets,
and a plug-in architecture for filters. It can
even save layered Photoshop files that iPhoto
can import and use. www.pixelmator.com
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Chapter 6

Working with Layers

Layers in image editing programs are great,
since they let you work on a photo without
changing the base image. However, you can’t
save layers in a JPEG file (likely the original
format of your photo), and if you save a
photo as a layered Photoshop file, the change
in filename extension prevents iPhoto from
seeing the edited photo. There are two solu-
tions to this problem.

First, you can “flatten” the image. squishing
the layers together into one. In Photoshop
Elements, when you're done editing, choose
Flatten Image from the Layers menu, and
then save the photo with its original name
and location. That way iPhoto sees your
changes to the photo, though you lose access
to the separate layers for future editing.
(There’s no need to flatten an image specially
in Pixelmator; you can just save.)

Second, if you want to retain layers for
multiple editing sessions in either Photoshop
Elements or Pixelmator, follow these steps:

1. Draga photo from iPhoto to the
Photoshop Elements or Pixelmator icon
in the Dock.

2. Add alayer, but don’t make any other
changes, so you retain a clean original.

3. Use Save As to save a copy in Photoshop
format on your Desktop. Close the file.

4, Drag the Photoshop file from your
Desktop back into iPhoto to re-import it.
Delete the copy on your Desktop.

5. From then on, use iPhoto to edit the
photo only in the external editor. Editing
in iPhoto flattens the layers silently.

v Tip

m Use a keyword to identify photos that
should not be edited in iPhoto.
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SLIDESHOWS

Web-Based Slideshows

This chapter looks at slideshows you
make within iPhoto and—for the most
part—display on your Mac or on devices
you own, like an iPhone or Apple TV.

If you want to know how to make a
Web-based slideshow that anyone can
view in their Web browser, flip ahead to
Chapter 8, “Publishing Photos on the
Web,” starting on page 135. That chapter
discusses various different ways you can
upload photos to a Web site—MobileMe,
Facebook, and Flickr being the easiest
ones—after which visitors can use the
tools on that Web site to play a slideshow
of your photos.

Although some people feel that a photo isn’t
real unless it appears on a piece of paper (and
iPhoto can satisfy those people too), one of
iPhoto’s coolest features is its capability to
present photos on screen in a wide variety

of ways—including slideshows on your

Mac; ever-changing Desktop pictures; and
slideshows on an iPod, iPhone, or Apple TV.

Gone are the days of the carousel projec-
tor and a darkened room; now a slideshow
involves high-resolution photographs
slipping on and off a computer screen,
complete with elegant transitions between
pictures. But that's only the beginning with
iPhoto. iPhoto ‘09 adds a number of elegant
slideshow themes that turn your photos
from still images to scenes in a movie.

iPhoto’s various onscreen presentation tools
are not only the best way to display your pho-
tographs to friends and relatives, but also the
best way for you to experience your own pho-
tos, whether through a constantly changing
Desktop picture or a slideshow-based screen
saver that kicks in whenever your Mac is idle.

Slideshows aren’t limited to your Mac, either.
You can copy both individual photos and
slideshows to your iPod or iPhone, and the
Apple TV turns out to be a wonderful way

to display photos on your large screen TV.
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Chapter 7

Types of Slideshows

iPhoto offers two types of slideshows,
which I call “basic” slideshows and “saved”
slideshows.

About basic slideshows:

Basic slideshows are quick to start from a
selection of photos and offer a basic set of
options that apply equally to all slides.

Use basic slideshows when you want to show
someone a set of photos quickly, without any
fuss or bother. Basic slideshows can also be
useful for reviewing just-taken photos.

Lastly, you can use only basic slideshows
when viewing images from a shared iPhoto
Library over a network.

About saved slideshows:

Saved slideshows appear in the source pane
like albums, books, cards, and calendars,
and any changes you make to them are
saved for the future. You can organize saved
slideshows in folders, duplicate them to
experiment with different approaches, and
export them for display on a computer, on
an iPod, on an iPhone, on an Apple TV, and
on MobileMe.

Use saved slideshows when you want to

put some effort into making a slideshow

as visually impressive as possible. You can
add and remove individual photos from the
slideshow, apply temporary effects to photos
during the slideshow, change the time each
slide appears on screen, adjust the Ken
Burns Effect for each slide, set the transition
between any two slides, and more.

What's particularly neat about saved
slideshows is that they're created with
default settings, so you can customize them
as much or as little as you like.

Arranging Basic Slideshows

Basic slideshows start with the image in
the upper-left position of the selection or
the album. So if you want to display the
pictures in the reverse order, choose either
Ascending or Descending (whichever one
isn't currently selected) from the Sort
Photos submenu of the View menu. Of
course, whatever sort is in effect applies,
so you can change the order by changing
to a different sort, too.

Book Slideshows

iPhoto also offers “book slideshows” that
are almost identical to basic slideshows.
When in book mode, click the Slideshow
button in the toolbar to run a slideshow
of each page in the book at full size.

The main difference between a book
slideshow and a basic slideshow is that
you can't pick any of the slideshow
themes or use the Ken Burns Effect. Other
settings, such as showing photo titles and
scaling photos to the screen, either aren’t
available or don’t work, since the book
page display preempts them.

Book slideshows are a great way to gain
extra benefit from the work of putting
together a book.
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v Tip Slideshow Tools Overview
W iPhoto '09 shuffled the slideshow con- When you select a saved slideshow in the
trols, such that the Slideshow button source pane, iPhoto displays a new set
in the toolbar plays a basic slideshow of tools for customizing your slideshow
instead of starting a saved slideshow. (Figure 7.1).

Thumbnails of the photos

in the slideshow, in order. The current

Click one to display it. photo on
Source pane. Create and work Command- or Shift-click to which you're
with saved slideshows here. select muitiple photos. working.

v
o
m
wn
Saved g
slideshow in
the source ™ wions =
pane. E'
o
=
7]
o
<
m
)
; . <
Click to cre- Click to m
ate a saved move back =
slideshow e e i e IS T and forward
from selected through
photos. slides.
Click to export
Click to play the the slideshow
saved slideshow. . _ e
Click to display
the Settings win-  Use the size slider
Click to preview the dow for adjusting  to set the start
slideshow in the dis- Click todisplay  settings for the and end magni-
play pane; click again Click to select a the Music set- slideshow and for  fications for the
to stop the preview. slideshow theme. tings window. the current slide. Ken Burns Effect.
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Chapter 7

Creating and Deleting
Saved Slideshows

For total control over a slideshow’s pre-
sentation, create a saved slideshow. Saved
slideshows are also ideal if you plan to show
the same slideshow on multiple occasions.

To create a saved slideshow:

1. Select one or more photos or albums, and
click the + button under the source pane.

2. Inthe dialog that appears, click Slide-
show in the item icon list and enter a
name for the slideshow in the Name
field (Figure 7.2); then click Create.

iPhoto creates a new saved slideshow
in the source pane and displays the
slideshow tools under the display pane
(Figure 7.3).

To delete a saved slideshow:

¢ Select the saved slideshow in the source
pane, press (Delete), and click Delete when
iPhoto asks if you're sure. Or just press

to avoid the warning dialog.

¢ Select the slideshow in the source pane,
and then either choose Delete Slideshow
from the Photos menu or [Control]-click it
and choose Delete Slideshow from the
contextual menu.

v Tips

W iPhoto won't let you create a saved
slideshow if you select a book, card, cal-
endar, or another saved slideshow instead
of an event, album, or individual photos.

B You can also create a slideshow by dupli-
cating an existing one, which is helpful
for experimenting with different settings.
With the slideshow selected in the source
pane, choose Duplicate from the Photos
menu or (Contral]-click it and choose
Duplicate from the contextual menu.

I YT .

Name: | Touring Wales |
¥ Use salected items in new slideshow

(camer) )

Figure 7.2 When creating a saved slideshow via the +
button, iPhoto gives you a chance to change the auto-
matic name it creates based on the currently selected
album or event.

Touring Wales

Figure 7.3 iPhoto provides slideshow tools under the
display pane only when you select a saved slideshow
in the source pane.
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Music Settings

™ B4

"‘

Classic Ken Burns Scrapbook
. i
_ oA
=) )
e e
Shatter Sliding Panels Snapshots

Use settings as default Canuel

Figure 7.4 Select a theme for your slideshow. This
is the settings dialog for basic slideshows; saved
slideshows have exactly the same options in a
slightly different presentation.
- Slideshow Settings

All Slides This Slide

® Play each slide for a minimum of . ,
seconds

The music wi for as long as

Fit slideshow to music

Transition:
Speed:

Preview:

\ Wzt

T

Show Caption: Titles
v Show title slide ©
v Repeat slideshow
Scale photos to fill screen

Aspect Ratio: This Screen (16:10)

Figure 7.5 Configure settings for the entire slideshow.
The precise controls here vary by theme.

Setting up Slideshows

In iPhoto '09, there isn’t much difference
between configuring basic and saved
slideshows. Follow these basic steps after
clicking the Slideshow button for a basic
slideshow or creating a saved slideshow;
subsequent pages provide more details.

To set up a slideshow:

1. Select a theme. For basic slideshows, click
the Themes button in the settings dialog;
for saved slideshows, click the Themes
button in the toolbar. Click the desired
theme to select it (Figure 7.4).

2. Select the music you want to play, if any.
For basic slideshows, click the Music
button in the settings dialog; for saved
slideshows, click the Music button in
the toolbar to display the Music window
(see "Assigning Music to Slideshows,” on
page 119). Select a song or playlist, or
make a custom playlist.

3. Configure the overall slideshow settings.
For basic slideshows, click the Settings
button in the settings dialog; for saved
slideshows, click the Settings button
in the toolbar to display the Slideshow
Settings window (Figure 7.5).

4. For saved slideshows, configure each slide
individually by clicking the This Slide
button in the Slideshow Settings window.

5. Click Play or press (Return].
v Tips

B In basic slideshows, select Use Settings
as Default in Figure 7.4 to use the same
settings for future basic slideshows.

B The options in the Slideshow Settings
window change with the theme; only
Classic and Ken Burns have the controls
shown in Figure 7.5.
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Chapter 7

Selecting a
Slideshow Theme

Slideshow themes are new to iPhoto 09,
but they're easy to work with and make
slideshows even more visually compelling,

To select a slideshow theme:

1. For basic slideshows, click the Themes
button in the settings dialog; for saved
slideshows, click the Themes button in
the toolbar to open the themes dialog.

2. Click the desired theme to select it
(Figure 7.4, previous page).

3. For saved slideshows, either double-click

the desired them or click the Choose but-

ton.
v Tips

B You canchange themes at any time
by clicking the Theme button in the
slideshow controls for basic slideshows,
or the Themes button in the toolbar for
saved slideshows,

® Changing themes in a saved slideshow
resets your settings for music and other
options, which is a bit annoying.

B All the themes can display a “title slide”
that displays the name of the slideshow

on the first slide. Turn it on and off in the

Slideshow Settings window.

About Slideshow Themes

The Classic and Ken Burns themes pro-
vide the same functionality as previous
versions of iPhoto did; the others are new.

¢ Use the Classic theme to show one
picture per slide, with transitions and
captions (titles, descriptions, places,
and dates). The Scale Photos to Fill
Screen option causes a slideshow to
display only the center of portrait-
orientation photos, but eliminates
black bands on the sides.

¢ The Ken Burns theme offers the same
options as the Classic theme, and, in
saved slideshows, lets you configure
zooming and panning for each slide

individually.

¢ The Scrapbook theme builds pages
containing one to three photos in
scrapbook-style frames, and it flips
between the pages or layers photos on
top of one another on the pages. It's a
bit like a book slideshow, but doesn’t
require that you make a book first.

¢ The Shatter theme shows one photo
at a time much like Classic, but with
an animated transition effect that
“shatters” one photo and displays frag-
ments of the next before filling in the
rest of the next photo.

¢ The Sliding Panels theme shows one
to three photos on a page, sliding one
or more of them in and out as the
transition effect. You can set the back-
ground color.

¢ The Snapshots theme shows a stack
of photos, slowly scrolling them up the
screen and overlapping a new photo
on top of the stack every few seconds.
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(%] Music Settings

¥ Play music during slideshow

Source: Theme Music

Name Artist 4 Time
Ej You've Got A Frien Randy Newman 2:04
B Endless Summer 2:08
E Linus And Lucy Vince Guaraldi 3:02
8 Hey Now Red Garland 338
I Want Freedom Chris joss 3:43
m Doxy Miles Davis 4:54

Q- Gitems

Custom Playlist for Slideshow

Figure 7.6 Pick a song or playlist to play during your
slideshow.

(] Music Settings
Y Play music during slideshow

Source: Music

Name
e o

B california Girls
B God Only Knows
Bl Bluebirds Over Th
B Good Vibrations
Fi Echo Beach
Beachcombing

Beach Boys
Beach Boys
Beach Boys

Wi

L R )

Beach Boys
Martha and the Muffins

5w NN
= W W

B

Mark Knopfler & Em

Q~ beach ] 12 items

v Custom Playlist for Slideshow

California Girls
Beachcombing
Good Vibrations

Echo Beach

Apply

Figure 7.7 You can search for songs by entering a
search term in the search field, and you can drag

multiple songs to the custom playlist pane to make a

custom playlist for just this slideshow.

Assigning Music
to Slideshows

Un

less you plan to narrate your slideshow in

person, playing carefully selected songs from
your iTunes Library during the slideshow can
enhance the presentation.

To select music:

1.

5.

For basic slideshows, click the Music
button in the settings dialog; for saved
slideshows, click the Music button in
the toolbar to display the Music Settings
window.

Select Play Music During Slideshow.

From the Source pop-up menu, choose
a collection of music: iPhoto’s Sample
Music or Theme Music, songs you've
made in GarageBand, or playlists from
iTunes.

Select a song or playlist from the list
(Figure 7.6), or (Cmd)-click to select

multiple songs to create a custom playlist.

Click Apply.

v Tips

To search for a song, enter a search term
in the Search field. iPhoto narrows the list
as you type. Click the X button to reset it.

To make a custom playlist, you can also
click the Custom Playlist for Slideshow
checkbox and then drag (first to the side,
then down) selected songs to the custom
playlist pane (Figure 7.7).

To sort the list of songs, click the header
of the Name, Artist, or Time column;
sorting by time makes it easier to match
the music to your slideshow’s length.

Click the triangular Play button to play
the selected song; click it again to stop
playing. Or double-click a song to play it.
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Chapter 7

Selecting Default Settings

For basic and saved slideshows alike, it’s
important to set the default settings that
apply to each slide. You can then change the
settings for each slide in a saved slideshow,
but it’s best to start with the right defaults.

To adjust default settings:

1. For basic slideshows, click the Settings
button in the settings dialog; for saved
slideshows, click the Settings button
in the toolbar to display the Slideshow
Settings window (Figure 7.8).

2. Either set the length of time you want
each slide to play or select Fit Slideshow
to Music so it plays as long as the selected
music.

3. For Classic and Ken Burns slideshows,
choose a default transition, and set the
transition speed and direction, if avail-
able, by clicking the appropriate arrow
in the round direction controller. iPhoto
offers numerous transitions (Figure 7.9).

4. Select the desired checkboxes to display
captions (title, description, title and
description, place, or date) and a title
slide containing the slideshow’s name.

5. Select Repeat Slideshow if you want the
slideshow to repeat indefinitely.

6. Forsaved slideshows, choose the screen
dimensions (This Screen, 16:9 for HDTV,
4:3 for iDVD and TV, or 3:2 for iPhone)
from the Aspect Ratio pop-up menu.

7. For basic slideshows, click Play.
v Tip

B When you select Fit Slideshow to Music,
iPhoto complains at you if you have too
many photos to show for the length of
music selected. Select either fewer photos
Or more music.

(3] Slideshow Settings
All Slides This Slide
Play each slide for a minimum of 5.0

seconds

The music will repeat tor as long as the

Fit slideshow to music

Slide tio | b make the slides

Transition: Dissolve

Speed:

Preview: ' -

Show Caption: Places

Show title slide €
Repeat slideshow
Scale photos to fill screen

Aspect Ratio: This Screen (16:10)

Figure 7.8 Set the defaults for a saved slideshow in
the Slideshow Settings window. The options are very
similar for basic slideshows, which lose the Aspect
Ratio pop-up menu and gain Play and Cancel buttons.
5 e |
¥ None

Cube

Dissolve

Droplet

Fade Through Black

Flip

Mosaic Flip Large

Mosaic Flip Small

Mose In Figure 7.9 iPhoto provides
Page Flip awide variety of transi-
Push

tions, but | recommend

:e?elal using relatively few per
! | slideshow to avoid visual
Wipe

1 over-stimulation.
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Figure 7.10 Drag photos to a saved slideshow in the
source pane to add them to the slideshow.

Manipulating
Saved Slideshow Photos

Whereas basic slideshows merely present
the selected photos in the current sort order,
saved slideshows give you more control.

Use these instructions to add, remove, and
rearrange photos in saved slideshows.

To add photos to a slideshow:

¢ Select one or more events, albums, or
photos and drag them onto the saved
slideshow in the source pane
(Figure 7.10).

To remove photos from a slideshow:

# Select one or more photos in the scrolling
list of photos above the display pane, and

press (Delete).
To arrange photos in a slideshow:

¢ Before you create the slideshow, make an
album and drag the photos into the order
you want. iPhoto retains that manual sort
order in the saved slideshow.

¢+ After you've created a slideshow, drag
photos around in the scrolling photo list
above the display pane.

v Tips

B Alas, there's no way to see multiple rows
of thumbnails in the scrolling photo list;
those controls in the View menu apply
only to full-screen editing view.

B Pay attention to the sort order of the
album from which you create a slideshow.
There’s no shame in deleting a saved
slideshow and re-creating it after sorting
the source album properly.

B Ifyou're sorting by date, you'll probably
want to choose Ascending from the View
menu’s Sort Photos submenu to ensure
that your slideshow goes forward in time.
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Chapter 7

Customizing Slides

The last few pages have helped you get ready;

now it’s time to customize individual slides
in a saved slideshow. Remember that each
of these actions is optional, and each theme
offers only those options that make sense for
that theme!

To customize slides:

1. Click the Settings button to open the
Slideshow Settings window. Click This

Slide to switch to individual slide settings.

2. Select the first slide in the scrolling list
above the display pane to set its options
in the Slideshow Settings window
(Figure 7.11).

3. Choose one of the three effects to apply
to the photo. See “Editing Slide Photos,”
on the next page, for more information.

4, In Classic and Ken Burns, to override
the default slide duration, select Play
This Slide For, and click the up or down
triangle buttons to increase or decrease
the slide duration.

5. In Classic and Ken Burns, to override
the default transition, choose a different
transition from the Transition pop-up
menu. You can also override the default
transition direction and speed here.

6. Tosee how your changes look, click the
Preview graphic to preview the current
and next slides.

7. In the Ken Burns theme, use the Start/
End switch along with the display pane’s
size slider to control the effect. See
“Configuring the Ken Burns Effect,” on
page 124.

8. Select the next photo by clicking it in the
scrolling list. Then repeat steps 3-8 until
you've customized each slide as desired.

Q Slideshow Settings

All Slides This Slide

LY

Black & Whire

Sepia Antique

v Play this slide for . seconds

v Transition: Cube
Speed:

Preview:

v Ken Burns:

Figure 7.11 Use the Slideshow Settings window’s
controls to override default settings for slide duration
and transition type, direction, and speed. You can
also select effects and configure the Ken Burns Effect
here.

Duration Locked?

If you find yourself unable to change the
amount of time a slide will stay on screen,
the reason is likely that you selected Fit
Slideshow to Music in the All Slides pane
of the Slideshow Settings window. Since
iPhoto has to calculate the length of time
to display each photo when that checkbox
is selected, it prevents you from changing
the slide durations.
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Editing Slide Photos

You will most likely have edited your photos
before you create a slideshow, but if not, you
can do so while customizing your slides.
Some edits must be permanent; others don't
have to be.

To edit slide photos permanently:

1. Double-click the photo that's showing in
the display pane to switch to edit mode.

2. Make whatever changes you wish, and
when you're done, click the Done button
to return to your slideshow.

To edit slide photos temporarily:

You can make several types of temporary
edits that iPhoto applies to the photo only in
the saved slideshow. These changes do not
affect the original photo in any way.

¢ Click Black & White, Sepia, or Antique
in the Slideshow Settings window
(Figure 7.11, previous page) to apply
the related effect to the photo.

¢ Use the display pane’s size slider to zoom
in on the photo.

¢ Ifyou zoom in on a slide or are using a
theme like Sliding Panels that doesn’t
always have enough room for the full
photo, drag the photo to set what portion
of it appears.

v Tips

B Ifthe photo is rotated incorrectly, you
can fix it without entering edit mode by
choosing Rotate Clockwise ((Cmd)R)) or
Rotate Counter Clockwise ([Cmd)Option)[R])

from the Photos menu.

B Use temporary edits unless you want the

changes to apply everywhere.
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Chapter 7

Configuring the
Ken Burns Effect

In most cases, Apple’s defaults for the Ken
Burns theme provide a completely accept-
able result, even focusing on faces thanks to
iPhoto’s face detection capabilities. [Towever,
if you wish to zoom further, choose whether
to zoom in or out, or even turn off the Ken
Burns Effect for a slide, you can do so.

To configure the Ken Burns Effect:

1. Inasaved slideshow using the Ken
Burns theme, click the Settings button
to open the Slideshow Settings window
and click This Slide to switch to indi-
vidual slide settings.

2. Select the Ken Burns checkbox.

3. Click the Start end of the Ken Burns
toggle switch.

4, Usingthe size slider, zoom to the size at
which you want the photo to appear first
(Figure 7.12).

5. Dragthe photo in the display pane so
the starting view is showing.

6. Click the End side of the toggle switch.

7. Using the size slider, zoom to the size at
which you want the photo to fade out.

8. Dragthe photo in the display pane
so the appropriate part is showing
(Figure 7.13).

9. Click the Preview button in the toolbar
to see if your settings work as desired.

10. Select the next photo and repeat steps
2-8.

Figure 7.12 For my starting point on this slide, I've
zoomed in all the way and dragged the photo to focus
on the center of this flower.

Figure 7.13 For the ending point, | zoomed out most
of the way, and dragged the flower to a pleasing
position.

Manual Configuration
for Exported Slideshows

The default Ken Burns settings gener-
ally work very well, but note that they
are random, which means that the effect
won't necessarily be the same on any
two playings of the same slideshow. As
aresult, if you're particular about the
final slideshow, and particularly if you're
exporting the slideshow, you should

set Ken Burns manually for each slide.
Otherwise, you won't know how it will
work on any given playing.
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Play/Pause. Music settings.
Previous Next Theme Slideshow  Stop.
slide. slide. settings. | settings.

Figure 7.14 Move the pointer while a slideshow is
playing to reveal the slideshow controls.

Slideshow Advice

Although setting up and playing slide-
shows is easy. you can produce better
results by keeping these tips in mind:

¢ To avoid black edges (primarily with
portrait-orientation photos) in Classic
and Ken Burns themed slideshows,
either zoom in on photos or set the
Scale Photos to Fill Screen option.

¢ Avoid using images smaller than your
screen (in pixels), since they will look
jaggy when iPhoto scales them to fit.

¢ Remember that Macs can drive TVs
via an S-video cable (you may have to
buy an adapter). If you have a huge
television, why not use that for a
slideshow? The Apple TV and iPod
can also display photos on TVs easily.

¢ Ifyou're playing the same slideshow
continuously (at a party, for instance),
select a large iTunes playlist to avoid
repeating music.

¢ Ifyou have two monitors, slideshows
appear on the one containing the
iPhoto window.

Controlling Slideshows

To controlling a slideshow while t runs is
easy: move the pointer during a slideshow to
show the slideshow controls (Figure 7.14).

To run a slideshow:

4 For basic slideshows, select some photos
and click the Slideshow button.

¢ Forsaved slideshows, select the slide-
show in the source pane and click Play.

To control a slideshow:

¢ To pause and restart a slideshow, click
the Play/Pause button in the slideshow
controls or press (Spacebar).

¢ To move back and forth between slides,
click the left or right arrow button in the
slideshow controls or press ] or [-3).

¢ To display thumbnails of photos, move
the pointer to the bottom of the screen.
Drag the selection box to jump around in
the slideshow.

¢ To change the theme, music, or other
slideshow settings, click the associated
button in the slideshow controls.

¢ To stop the slideshow, click the X button
in the slideshow controls or press (Esc).

v Tips

B Moving between slides manually causes
music to stutter in iPhoto 8.0.2. It’s a bug.

B You can no longer rotate photos, delete
photos, or rate photos during a slideshow.
Nor can you change the duration of slides
while a slideshow is playing.

® Ifyou are in Photos and have a lot of
photos, don’t click the Slideshow button
without selecting photos first or iPhoto
will lock up for many minutes while it
builds a multi-thousand photo slideshow.
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Chapter 7

Exporting Slideshows

iPhoto slideshows are great if people can
gather at your computer, but you're not
limited by the location of your Mac, now
that you can export slideshows to an iPod,
iPhone, Apple TV, or QuickTime movie.

To export a slideshow:

1. Select the saved slideshow you wish to
export.

2. Click the Export button in the toolbar.

iPhoto displays the Export Your
Slideshow dialog.

3. Select the checkboxes for the dimensions
you want to export, based on where the
movie will be viewed (Figure 7.15).

4. Particularly if you plan to sync your
slideshow to an iPod, iPhone, or Apple TV,
select Automatically Send Slideshow to
1Tunes.

5. Click Export and navigate to the desired
location for the file(s); iPhoto defaults to
a new iPhoto Slideshows folder it creates
in your Pictures folder.

6. Locate your movie in the Finder and
double-click it to see the results in either
iTunes or QuickTime Player.

v’ Tips

B Mouse over the i button at the right of
each size line for an often-inaccurate
estimate of the size of the slideshow files.

m For more control, click Custom Export
and choose a type of movie to export
from the Export pop-up menu in the Save
dialog that appears (Figure 7.16). For
the 3G, MPEG-4, and QuickTime Movie
choices, click the Options button to view
and change the low-level settings. Most
people won't ever need to do this.

Sizes: Wl Mobile . . ®  480x300 O
W aedium . . . ® RADxdDO ©)
arge = e s s BAOG
!D?aohr . 1280x800 {1
W Automatically send slideshow to (Tunes

o (o) o)

Figure 7.15 In the Export Your Slideshow dialog,
select the size of the movie(s) you want iPhoto to
create, based on where the movie will be viewed.

Save As: [IPhaca Festval Mile 2008.mp4 =

[« »]|[22 =im) |G Photo Siideshows ] Qsearch )
[¥oevices (N @ lihacaFestival Mile 2008-Display.mdy | |
E ey 1, hhata Festival Mile 2008- Largemdy
am | 7| ihaca Festival Mile 2008-Medlum. may
) DopwieZeus 1 Mhaca Festrval Mile Z008-Mobile.may
I xronos
Movie 10 3G
¥ SHARED
Movie to Apple TV L

Movie to iPhone
Maovie tv iPhone (Cellular)

1 MovietwiPud 3
S ¥ Movie to MPEG-4 b
Movie 1o QuickTime Mavie =
( New Folder ) ESee)

Figure 7.16 Click Custom Export and choose a format
type for additional control over the movie dimensions
and compression settings.

Exporting Photos to QuickTime

There’s another quick and dirty way to
create a simple QuickTime movie.

1. Select the photos you wish to export,
chaoose Export from the File menu

((Cmd)Shift[E)), and click the QuickTime
button.

2. Enter the maximum width and height
for the images, a slide duration, and
select a background color.

3. To include the music associated with
basic slideshows, select Add Currently
Selected Slideshow Music to Movie.

4. Click Export, name your movie in the
Save dialog, choose a destination for it,
and click OK to build the movie.
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Figure 7.17 Select slideshows to sync to an iPhone or
iPod under Movies in the Video tab of the device set-

tings screen.

__z16PM
Videos

o WNYC's Radio Lab
(1 Episode)

Figure 7.18 Slideshows synced to an
iPhone or iPod touch appearin the
Videos list in the iPod app.

QuickTime for Windows

One of the nice things about QuickTime
is that it's available for both the Mac and
Windows. Some Windows users don't
have QuickTime installed, however, so
you may need to tell them how to get it.
Send them to www. apple. com/quicktime/
download/for a free copy.

Syncing and
Distributing Slideshows

Once you've exported a slideshow, what do
you do with it?

Ways to use exported slideshows:

*

To sync a slideshow to an iPhone or
video-capable iPod, select the device

in the iTunes sidebar, click the Video
(iPhone) or Movies (iPod) tab, and
select the slideshow in the Movies list
(Figure 7.17). Slideshows appear in

the iPod app’s Video list on the iPhone
(Figure 7.18), in the iPod touch’s Video
app, and in a normal iPod’s Video list.

To view a slideshow on an Apple TV,
make sure the Apple TV is connected to
iTunes, and then find the slideshow in the
Shared Movies list in Movies.

Exported slideshows play in QuickTime
Player, and you can copy them to a writ-
able CD or DVD disc for friends and fam-
ily with computers.

If you use Custom Export to make an
MPEG-4 or QuickTime Movie file, you
can drag it into iPhoto to import it, and
then add it to a MobileMe Web album to
upload it for viewing on the Web.

Most slideshows will be too large (over
5 MB) to send via email, so use a service
like Dropbox (www. getdropbox.com) to
send a link to the file via email instead.

If you have FTP or Web space available
with your Internet account, upload the
movie (perhaps using iWeb) and send
people the link.

Upload to YouTube at www. youtube. com.
YouTube can take most formats, and

it wants the highest quality, but videos
must be less than 1 GB and 10 minutes.
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Chapter 7

Creating an
iMovie Slideshow

What if you want to add narration or
captions to a slideshow? Turn to Apple’s
iMovie video editor. These instructions are
a brief overview: refer to iMovie’s help or Jeff
Carlson’s iMovie 09 & iDVD for Mac OS X:
Visual QuickStart Guide for more details.

To create an iMovie slideshow:

1. IniMovie, click the Photos button,
select an album, and then drag the
desired photos into the Project Browser
in the order you want (Figure 7.19).

2. Double-click a photo to display the clip
inspector. Enter a duration longer than
you expect to speak and click Done.

3. Torecord audio, click the Voiceover
button to open the Voiceover window,
click the left edge of the photo you just
tweaked, and record your narration,
clicking anywhere in the project to stop
recording (Figure 7.20).

4. Double-click the purple audio clip under
the photo to see its duration. Then dou-
ble-click the photo and set its duration to
match the length of the voiceover.

5. To adjust the Ken Burns Effect zoom
and position, double-click the tiny crop
button in the photo and adjust the start-
ing and ending positions in the Viewer
pane to the right. You can also click Fit to
display the entire photo (with black bars)
or Crop to crop it to fit.

6. To add a title, click the Titles button and
drag a title style to a photo. Type your
text in the Viewer pane (Figure 7.21).
Drag the edges of the blue title balloon to
match the photo clip length.

7. Repeat for each photo.

Drag photos to the Project
Browser to add them; you
work with them here too.

Photos appearin
the Event Browser
when you select

) : an album.
Drag and Determine clip )
expandto | length here. Titles button.
fset ﬁge Voiceover ~ Photos button.
engt | Viewer pane.

button.

Figure 7.19 Use iMovie to produce and distribute
slideshows that are significantly more complex than
is possible in iPhoto alone.

Voiceover

Record From: Sennheiser USB Headset

Input Volume: + 4 35%

tef: HERNERRRRRERNRRRRRER
righ: RNENRRRERRRARRRRNER

Noise Reduction: # Tews _20d8

v Voice Enhancement

Play project audio while recording

Figure 7.20 To record audio, click the Voiceover
button, click the left edge of the photo you want to
describe, and speak. Click anywhere else to stop.

Figure 7.21 To add a title, click the Titles button and
drag a title style to a photo. Then type your title in the
Viewer pane.
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Drop photosin  Burn
the drop zones. button.

Theme pane. Click to
choose a theme.

Figure 7.22 Select a theme for your DVD slideshow in
the Themes pane; switch to the Media pane to drop
photos or movies into the drop zones.

Photo list. Drag to
rearrange; press
Delete to remove.

Media pane. Click to
switch between audio,
photos, and movies.

Click to
return to Drag photos to
Clickto  the main the photo list

to add them.

preview.

Screen.

Figure 7.23 Customize your slideshow in iDVD using
the Media pane.

Py P bhmre

L ™

Figure 7.24 Drag photo albums from the Photos pane
into iDVD’s Magic iDVD screen to create slideshows
of them. Switch to the Audio pane and drag songs or
playlists onto the same spots to add music to your
slideshows.

Creating a DVD
Slideshow with iDVD

iPhoto can send a set of photos to iDVD to
create a DVD slideshow that can be viewed
on any TV with a DVD player. You must have
a Macintosh with a SuperDrive to burn such
a slideshow to disc.

To create a DVD slideshow with iDVD:

1. Select one or more albums or slideshows
((shift}- or [Cmd]-click to select multiple
items), and choose Send to iDVD from
the Share menu.
iPhoto works for a bit, launches iDVD,
and shows the iDVD main screen with
pre-built iDVD slideshows.

2. Click the Themes button in the lower
right, choose a theme, and customize it
with text and images (Figure 7.22).

3. Toadd audio, photos, or video to the
main title screen; click the Media button;
click Audio, Photos, or Movies in the
upper right; and drag items to drop zones.

4. Double-click a slideshow icon in the main
screen to switch to a screen where you
can add, delete, and rearrange photos
(only for the album-based slideshows),
plus set a slide transition, select music,
and set other options (Figure 7.23).

5. Asyou work, use the Preview button to
verify that your slideshow plays as you
desire. A small player window simulates
a DVD remote control.

6. When you're ready, click the Burn button
to start burning your DVD.

v Tip

B For even easier DVD slideshow creation,
launch iDVD, choose Magic iDVD from
the File menu, and drag albums and
music into the Photos area (Figure 7.24).
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iDVD SLIDESHOW TIPS

Chapter 7

iDVD Slideshow Tips

Look to other sources for full instruc-

tions on how to use iDVD, such as Jeff
Carlson’s iMovie 09 & iDVD for Mac OS X:
Visual QuickStart Guide or Jim Heid's The
Macintosh iLife 09, both from Peachpit Press.
That said, these tips should help you use
iDVD more effectively.

Tips for using iDVD:

Making Good DVD Slideshows

It’s easy to work with iPhoto and iDVD,
but you must still expend a fair amount
of effort when creating a DVD-based
slideshow if you want good results. Keep
in mind that TV quality will always be
lower than the computer screen quality.

# UseiDVD's Preview heavily, and run

¢ iPhoto sends saved slideshows to iDVD through all your slideshows from start
as QuickTime movies, which you can’t to end before burning.
edit inside iDyD. Remem-ber to choose o Landscape photos work better than
sn:aspect Tabio or your SthSh_OW Fhat portrait photos, which have large black
matches the TV screen where it will be bevders
shown!
© The99-oh TS — ¢ Make sure Always Scale Slides to TV
£ ?9 p otq ke 1‘es m?r HILang Safe Area is set in iDVD’s Slideshow
prencus REsORSGHD B snewgEe. preferences pane (choose Preferences
¢ Save your iDVD project with a good from the iDVD menu and click the
name; it’s the disc name in the Finder. Slideshow button).
¢ Turn on Show TV Safe Area in the View ¢ Resist the temptation to put as many
menu to verify that everything you're photos in each slideshow as possible;
doing will fit on a TV screen. instead, whittle down the slideshow to
o If iect Al A Biriginal Pl the most relevant photos. Very similar
e ) Flgma oS photos are boring when seen one after
to DVD-ROM Contents in iDVD’s Shote,
Slideshow preferences pane, iDVD also
makes the photos available as files on ¢ You can choose the duration between
the DVD for use with computers. These slides, but it's generally best to fit the
are stored as normal files and not in an slideshow length to the audio length.
iPhoto Library folder. But don't pick so much music that
_ o individual slides appear for too long.
¢ Quit all unnecessary applications when
burning; if anything interrupts the burn ¢ Be forewarned; it can be hard to find
process, it can ruin your DVD-R disc. good music for slideshows. Think
o DVD-Rdiscshold47GB. s babl about the subject and the mood of the
: ) »HEJRR Prane Ry photos, and then browse through your
won't be able to fill one th slideshows. {Tunes collection to see what songs
ToNseHL Fesmancanavileo, might fit. It's easier to browse quickly
in iTunes than in iDVD.
¢ C(Click the Motion button (it has curved
arrows in the middle) to turn off the
theme's motion while you work.
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Figure 7.25 Click
the Set Desktop
button to set the
selected photo
as your Desktop
picture.

5“'"'-

!.'ﬁll"l

Figure 7.26 With a single click, you can put the photo
you have selected in iPhoto on your Desktop.

» iProte Alums
¥ Faidare
&2 Desiraps
(L iPhare Selncion

b |

W Change picture: | every 5 minutes
! Random order
T Tranalutent Manu Bar (.;g

Figure 7.27 In the Desktop view of your Desktop &
Screen Saver preferences, configure how you want
your Desktop pictures to appear, and how often they
should rotate.

Setting the
Desktop Picture

In Mac OS X, you can display a picture on
your Desktop, and with iPhoto, putting one
(or mare, in rotation) of your photos on your
Desktop is a matter of just clicking a button.

To set the Desktop picture:

1. IniPhoto, select one or more photos,
and click the Set Desktop button or
choose Set Desktop from the Share menu
(Figure 7.25).
If you selected only one photo, iPhoto
immediately changes the picture on your
Desktop (Figure 7.26).
If you selected multiple photos, iPhoto
opens the Desktop & Screen Saver prefer-
ence pane (Figure 7.27).

2. Ifyou selected multiple photos, choose
how you want the images to appear on
the Desktop.

v Tips

B You can also display the photos in an
iPhoto event or album on your Desktop
by selecting it in the iPhoto Albums list
in the Desktop & Screen Saver preference
pane’s Desktop view.

W Ifthe picture is in landscape orientation,
iPhoto scales the photo to make it fit.

B Ifthe photo is in portrait orientation,
iPhoto takes a landscape chunk out of the
middle to display on the Desktop. Stick
with photos in landscape orientation, or
crop them appropriately first.

B iPhoto can put a picture on only one
monitor. To put a picture on a second-
ary monitor, open the Desktop & Screen
Saver preference pane and drag a photo
from iPhaoto into the photo well for the
second monitor’s Desktop picture.
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Chapter 7

Using Photos
as a Screen Saver

Alas, the Set Desktop button in iPhoto no
longer sets selected photos as a screen saver,
but it’s no great loss.

To use photos as a screen saver:

1. Open the Desktop & Screen Saver pane
of System Preferences (Figure 7.28).

2. If necessary, click the Screen Saver button
to switch to the Screen Saver view.

3. Inthe Screen Savers list, scroll down
in the Pictures collection and click an
iPhoto event, folder, album, smart album,
Web album, or photo feed whose photos
you want to cycle through as your screen
saver.,

4. Select a display style: Slideshow, Collage,
or Mosaic.

5. Adjust the Start Screen Saver slider to set
how long the screen saver should wait
for activity before kicking in. If you want
to set a hot corner, click the Hot Corners
button and pick a hot corner in the dialog
that appears.

6. To configure options for how the screen
saver slideshow looks, click Options and
then adjust the settings in the Options
dialog. (Figure 7.29 shows the Slideshow
options; the Collage and Mosaic settings
are different.) Click OK when you're done.
Mac OS X's screen saver is now set to use
the selected photos. The next time your
screen saver kicks in, you'll see it display-
ing those photos.

v Tip

B To make the screen saver use all your
photos, create a smart album that con-
tains all photos taken after 1904 (or some
other equally early date).

I Holiday Card 2008
Ot Books
i o0 Cutendars.

My FaVOiEeL (45 SEMY)

I vest of Trstan

W nosean 2004

W coviitrmas Letter 2006
I ratt esers 2007

W Coual Trp

Figure 7.28 Select an event, folder, album, or smart
album in the Screen Savers list to use those photos
as your screen saver.

M Present slides in random order
M Cross—fade between slides

™ Zoom back and forth

™ Crop slides to fit on screen

[T Keep slides centered

( Cancel ) 0K

Figure 7.29 Configure how the screen
saver displays your photos in the
Options dialog. Play with these settings
to see how they interact with the photos
you're using—I've found varying results
with different types and sizes of photos.

Screen Saver Styles

Mac OS X 10.5 Leopard’s screen saver
provides three styles:

¢ Slideshow uses the Ken Burns Effect
and displays a single photo at a time.

¢ Collage has a single large photo fade
in, shrink, and then remain on screen
as subsequent photos overlap it.

¢ Mosaic picks one photo as the master
and then uses other photos to make a
mosaic of the master image. It needs a
lot of images and a fast Mac.
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Making Slideshows

Syncing Photos
to an iPod or iPhone

The best way to carry photos with you is

in your color-screen iPod or iPhone, which
can display them in their full glory. Though
the photos come from iPhoto, you must use
iTunes to copy them to your iPod or iPhone.

o B g V0 B B 1
) Wty 8 s 111
o

To copy photos to an iPod or iPhone:

Figure 7.30 Choose which photos will be copied to

your iPod or iPhone in the Photos screen in iTunes. L. It ahes, Seleot y6iin 160, or iEhehe 1l

the Devices list.

2. Click the Photos tab to display
the photo-syncing preferences
(Figure 7.30).

vm‘!‘""g Ph.OtOS 3. Click the Sync Photos From checkbox
on an iPod or iPhone and select All Photos and Albums, Most

It's easy to view the photos once you've Recent Events, or Selected Albums.

copied them to your iPod or iPhone. 4, Ifyou selected Most Recent Events,

¢ On an iPod with a clickwheel, select choose how many from the pop-up menu,

Photos at the top level and press the
center button to list albums. Continue
pressing the center button to see
thumbnails and then full-size photos.
Use the Forward and Back buttons

to navigate through the photos, or
press the Play button to switch into
slideshow mode.

On an iPhone or iPod touch, tap the
Photos app, tap an album to see its
thumbnails, and then tap a photo to
see it full size. Swipe right and left

to move through the photos, or tap
the bottom of the screen and tap the
triangular play button to switch into
slideshow mode. Remember that you
can rotate the iPhone or iPod touch
between landscape and portrait
modes to avoid black bars on the sides.
You can also pinch to zoom in and out,
and drag a zoomed photo to navigate
around in it.

and if you chose Selected Albums, select
specific albums in the list.

5. Click Apply to save your preferences and
start the synchronization process.

v Tips

B To save space, iTunes shrinks the photos
for display on the tiny screen.

B I[fyou want to use a capacious iPod (not
iPhone) to move photos to another Mac,
select the Include Full-Resolution Photos
checkbox in the Photos tab in iTunes.

m Ifyou have limited space on your iPod or
iPhone, it’s best to copy individual events
or albums rather than everything, Smart
albums and the Last 12 Months album
are especially useful here.

B iTunes shows you how many photos
are in each album, which can give you a
rough approximation of which albums
will fit.
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SYNCING PHOTOS TO AN APPLE TV

Chapter 7

Syncing
Photos to an Apple TV

A great way to display a slideshow from
iPhoto is on a large-screen TV connected to
an Apple TV. The Apple TV is easy to con-
nect to iPhoto, although, as with the iPod
and iPhone, syncing works via iTunes. The
following instructions assume that you've
already paired your Apple TV to iTunes.

To copy photos to an Apple TV:

1. IniTunes, select your Apple TV in the
Devices list.

2. Click the Photos tab to display
the photo-syncing preferences
(Figure 7.31).

3. Click the Sync Photos From checkbox
and select All Photos and Albums or
Selected Albums.

4. Ifyou chose Selected Albums, select
specific albums in the list.

5. Click Apply to save your preferences and
start the synchronization process.

v Tips

B You can also set the Apple TV to stream
photos from a different shared iTunes
Library, which doesn’t copy the photos
from the Mac to the Apple TV. Use the
Apple Remote to connect the Apple
TV to the shared iTunes Library in the
Settings > Computers menu. Once that’s
done, use the Photos tab in iTunes to
select albums to stream via Photos >
Shared Photos on the Apple TV.

W Photos originally saved with iPhoto 4 or
earlier may be rotated incorrectly on the
Apple TV. To fix such photos, select them
and choose Revert to Original from the
Photos menu, and then rotate each photo
again.

Figure 7.31 Choose which photos will be copied to
your Apple TV in the Photos tab in iTunes.

Viewing Photos on an Apple TV

The Apple TV can display random photos
from your synced collection as a screen
saver, and you can also display them
manually as a slideshow. Use the Apple
Remote to navigate the menus on your
Apple TV for these instructions.

# Select Settings > Screen Saver to select
the screen saver style and set options
such as how quickly it comes on and
whether or not it runs when music is
played through the Apple TV. Select
Settings > Screen Saver > Photos to
pick an album to use with the Photos
screen saver, which scrolls multiple
photos up the screen. And select
Settings > Screen Saver > Slideshow to
run a standard screen saver with the
Ken Burns Effect. (The Album option
displays album artwork from iTunes.)

# Select Photos > My Photos to pick
a synced album and either display
photos manually using the buttons on
the Apple Remote or start a slideshow.
You can configure slideshow settings
in Photos > Settings.
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PUBLISHING

PHOTOS ON THE WEB

MobileMe,

Facebook, and Flickr Accounts

To publish photos to one of these Web-
based services, you must first have an

account on the service you wish to use.

*

MobileMe costs $99 per year, although
you can sign up for a free trial. To start
the process, go to www.me. com and look
for a “Sign up for a free trial” link.

Facebook is free, but it's more than just
a photo sharing site, so be aware that
you're getting into a social networking
system. Sign up at www. facebook. com.

Flickr, owned by Yahoo, can be used
for free, or you can upgrade to a Pro
account to remove the free-account
limitations of 100 MB of photo
uploads per month, 200 photos in
your photostream, and the capability
to display only smaller images. Pro
accounts cost $24.95 per year. Start
signing up at waw. flickr. com.

Which you choose is entirely up to you.
My feeling is that MobileMe is best for
sharing with groups of people you already
know, Facebook is best for sharing with
friends on Facebook, and Flickr is best for
sharing with the world at large.

One of the greatest changes in photogra-
phy has been the rise of the Web. Before
the appearance of sites like MobileMe,
Facebook, and Flickr, it was difficult or
impossible for the average person to pub-
lish a photo such that it could be seen by
many others, but that’s no longer true. As
of early 2009, Facebook contains upwards
of 13 billion photos, and Flickr has another
3 billion (Apple hasn't released numbers for
MobileMe). People love Web publishing.

Those growth trends are just going to
continue for the foreseeable future, since

it's becoming ever easier to post photos to
the Web, thanks in part to new features in
iPhoto. Previously, it was a pain to upload to
anywhere but .Mac (the previous name for
MobileMe), but with iPhoto '09, putting pho-
tos on Facebook and Flickr is just as easy.

Although it's easy, serious Flickr users
should note that iPhoto doesn’t offer as
many options as third-party plug-ins do. So
if you get started uploading to Flickr with
iPhoto and find yourself wanting more than
it provides, don't hesitate to check out other
utilities.

That said, let’s look at how to publish photos
to the Web, and in the next chapter, we'll
turn our attention to how to share photos
with a small set of people in other ways.
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SETTING UP FACEBOOK

Chapter 8

Setting up Facebook

Before you can upload to your Facebook
account, you must make a connection
between iPhoto and Faceboaok, so Facebook
will accept uploads from iPhoto. This needs
to be done only once, the first time you
attempt to upload to Facebook.

To connect iPhoto with Facebook:

1. Select one or more photos, albums, or
events (including movies!), and either
click the Facebook button or choose
Facebook from the Share menu.

iPhoto asks if you want to set up iPhoto
to publish to Facebook (Figure 8.1).

2. Click Set Up.
iPhoto presents a dialog with which you
can log in to Facebook (Figure 8.2).

3. Enter the email address you used for
Facebook and your Facebook password,
and select the Keep Me Logged In To
iPhoto Uploader checkbox, unless you're
working on someone else’s computer.
Then click the Login button.
iPhoto may show another dialog ask-
ing you to allow iPhoto access to your
Facebook account (Figure 8.3).

4. Ifyou get the Allow Access dialog,
click the Allow button to finish the
setup process.

Do you want to set up Photo to publish to Faccbook?

TR Hiamt RO S ey ARnsmm it e g § B e Sy
Sl 88 s 1 vt Sepes proscy

(Eome) )

Figure 8.1 On the first attempted connection to
Facebook, iPhoto asks if you want to connect iPhoto
to your Facebook account.

iPhoto Uploader

Login to Facebook to enjoy the full functionality of iPhato Upleader, If you don't
want this to hapoen, 90 to the normal Faccbook loain page.

Emaik aceftidbits.com

Password: I I

([} Keep me logged in ta IFhoto Upicader

Forgot your password !

Security Note: Altor bogin, you should never provide your password to an outside
application. Facebook does not provide your comtact information to IPhoto
Uploader.

Figure 8.2 Enter your Facebook login information and
click the Login button.

= Allow Access?
Allowing (e Uploader access will et it pull your profile information, photes,
your friends’ info, and ather content that it reguires to work.

W Keep me logyed in 10 Photo Uploader

+1 Allaw of cancel

By srocecdicg. you are aliowing Paoto Unloader t0 scoant your information end yew ant sgeesing
18 e Lacebosd Terms of Uss 14 vour use ol Pous Ugissder

Figure 8.3 Click the Allow button to let iPhoto access
your Facebook account.
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Publishing Photos on the Web

Do you want to sct up Photo to publish to Flickr?
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Figure 8.4 On the first attempted connection to Flickr,
iPhoto asks if you want to connect iPhoto to your
Flickr account.
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Figure 8.5 The first step in connecting iPhoto and
Flickr is to sign in to your Yahoo account.
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Figure 8.6 After signing in, you must allow iPhoto to
link to your Flickr account.

flickr R —— B S

Mums Ve o Opesivs . Costerw . Gresps - Suple I ™ S

Hi Adam C. Engst
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Figure 8.7 When you’re done, Flickr confirms that
you've authorized iPhoto to upload photos.

Setting up Flickr

Before you can upload to Flickr from iPhoto,
you must link iPhoto to your Flickr account.
This needs to be done only once, the first
time you attempt to upload to Flickr.

To connect iPhoto with Flickr:

1. Select one or more photos, albums, or
events (including movies!), and either
click the Flickr button or choose Flickr
from the Share menu.

iPhoto asks if you want to set up iPhoto
to publish to Flickr (Figure 8.4).

2. Click Set Up.

iPhoto opens a Web page in your default
Web browser, from which you can log in
to your Yahoo account, which provides
access to Flickr (Figure 8.5).

3. Enter your Yahoo ID and password, and
click the Sign In button.

Another Web page loads, asking you to
authorize the link between iPhoto and
your Flickr account (Figure 8.6).

4. Click the OK, I'll Allow It button to finish
the setup process.

Your Web browser displays a confirma-
tion page (Figure 8.7), after which you
can return to iPhoto to continue publish-
ing photos.

v Tip

W For geotags to be uploaded to Flickr and
for your photos to be mapped automati-
cally, select Include Location Information
for Published Photos in iPhoto’s
Advanced preferences. You may also need
to set your account to import geotags at
www. flickr.com/account/geo/exif/.
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PUBLISHING TO MOBILEME

Chapter 8

Publishing to MobileMe

Your MobileMe Gallery lets you link photos
in iPhoto with a Web page on MobileMe.
Albums on MobileMe can be viewable by
anyone, by just you, or by a set of people with
whom you share a user name and password.

To create an album on MobileMe:

1. Select one or more photos, albums, or
events (including movies!), and either
click the MobileMe button or choose
MobileMe Gallery from the Share menu.

iPhoto asks who can see your album and
how it will appear (Figure 8.8).

2. From the Album Viewable By pop-up
menu, choose Everyone, Only Me, or a
user if you've created any.

3. Select the desired display, download-
ing, and uploading options from the
checkboxes, and click Publish.
iPhoto creates a new album in the
MobileMe Gallery list in the source pane
and starts processing and uploading
your photos (it'’s slow!). When it's done,
it shows the URL to your album at the
top of the screen (Figure 8.9).

To create user names and passwords:

1. From the Album Viewable By pop-up
menu in the MobileMe Gallery dialog,
choose Edit Names and Passwords.

2. Inthe dialog that appears, click the + but-
ton, enter a name and password (click or
press (Tab) to switch fields), and click OK
(Figure 8.10).

v Tips

B The URL to your album appears at the
top of the screen; click it to visit the page.

B The Settings button in the toolbar dis-
plays the dialog shown in Figure 8.8 for
after-the-fact changes.

Would you like to " to your Callery?

This will create an album in Adam Engst's MobileMe Gallery. The album can be viewed
modern web browser. The title of this album will be visible to everyore

Album Viewahle by: | Everyone ﬂ
Allow: ™ Downloading of photos or entire album
lUploading of phatos via web browser
"1 Adding of phatos via email
Show: ™ Phota titles
| Email address for uploading photos

Advanced: | | Hide album on my Gallery page

Download quality: I Actual Size E
( Hide Advanced ) (_Cancel ) (EPublish=)

Figure 8.8 iPhoto presents you with choices about
who can see your album and how it will be displayed.

Figure 8.9 When you click Publish, iPhoto creates an
item in the MobileMe Gallery list for the new album.

o T 2
family gstPhotos  Crandma Estelle’s Apartment
friends

T3 7] Mame miy consist of a-2, 0-9, undericares and & vingle dot )
| *1= " Password should be four characters or mare; e, [ Cancel ) (N0

Figure 8.10 Enter names and passwords to create
login credentials for people you want to be able to
see your photos.

v/ More Tips

B The Advanced settings let you hide the
album on your MobileMe Gallery page.
and., if you allow downloading of photos,
set the quality of the downloaded photos.

B Click the Tell A Friend button to create
an email message with login information.
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Publishing Photos on the Web

Do you want to publish “Triennial 2008" to Facebook?

This creates an album in Adam C. Engst’s Facehook account. To use a
different Facebook account, click Change Accounts.

Photos Viewable by: [ Friends of Friends 84

| certify that | have the right ta distribute these photos
and that they do not violate the Terms of Use.

(ChangeAccounts ) (" Cancel ) (SPublish)

Figure 8.11 iPhoto presents you with choices about
who can see your album on Facebook.

Figure 8.12 When you click Publish, iPhoto creates an
item in the Facebook list for the new album.

Figure 8.13 You can find your photos in your profile
in Facebook; note that faces you've identified in
iPhoto appear as tags, and mousing over a person’s
face displays his or her name.

Publishing to Facebook

Facebook is great for publishing photos that
can be viewed by groups of your Facebook
friends. What's cool about Facebook is the
way faces in your photos can (theoretically)
link to your friends’ accounts.

To create an album on Facebook:

1. Select one or more photos, albums, or
events (but not movies!), and either click
the Facebook button in the toolbar or
choose Facebook from the Share menu.

iPhoto presents options as to who can see
your album (Figure 8.11).

2. From the Photos Viewable By pop-up
menu, choose Everyone, Friends of
Friends, or Only Friends.

3. Click Publish.

iPhota creates a new album in the
Facebook list in the source pane and
starts processing and uploading your
photos (a slow process). When it's done,
it shows the URL to your album at the
top of the screen (Figure 8.12).

v Tips

B For aperson you've identified in a photo
to be tagged (with a link to his Facebook
account—see Figure 8.13), his Facebook
email address must be entered in the
Information dialog for his snapshot on
the Faces corkboard. As of iPhoto 8.0.2,
this is still a little flaky.

W Photos added to the album on Facebook,
along with tags added to your photos on
Facebook will sync back to iPhoto.

B The Settings button that appears in the
toolbar when you're in a Facebook album
displays the dialog similar to the one
shown in Figure 8.11 to let you change
who can see your photos or remove the
current Facebook account from iPhoto.
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PUBLISHING TO FLICKR

Chapter 8

Publishing to Flickr

Whereas Facebook is a social networking
site, Flickr is a more generalized photo-
sharing service. Geotagged photos uploaded
to Flickr can retain their geotags, allowing
them to be associated with other geotagged
photos on maps and location pages in Flickr.

To create an album on Flickr:

1. Select one or more photos, albums, or
events (but not movies!), and either click
the Flickr button in the toolbar or choose
Flickr from the Share menu.

iPhoto gives you options as to who can
see your album and how large the largest

size photo on Flickr will be (Figure 8.14).

2. From the Photos Viewable By pop-up
menu, choose Only You, Your Friends,
Your Family, Your Friends and Family, or
Anyone.

3. From the Photos Size pup-up menu,
choose Web, Optimized, or Actual Size.

4, Click Publish.

iPhoto creates a new album in the Flickr
list in the source pane and starts pro-
cessing and uploading your photos (a
slow process). When it's done, it shows
the URL to your album at the top of the
screen (Figure 8.15).

v’ Tips

B The Settings button that appears in the
toolbar when you're in a Flickr album dis-
plays the dialog similar to the one shown
in Figure 8.14 to let you change who can
see your photos or remove the current
Flickr account from iPhoto.

B Photos you add to linked photo sets on
Flickr are synced to your Flickr Web
album, as are tag and name changes you
make on Flickr.

Do you want to publish “Beaumaris, Caernarfon, &
Dolbadarn Castles” o Flicke?

This rreates a *sm” of pharos in Adam €. Fagst's Flickr Photastream. Too
use & different Flickr account, elick Change Accounts.

Photos Viewable by: | Anyone [ )
Photo size: [Web 18
(Coubiah )

Figure 8.14 iPhoto presents you with choices about
who can see your album on Flickr, and how large the
maximum photo size should be.

Figure 8.15 When you click Publish, iPhoto creates an
item in the Flickr list for the new album.

v’ More Tips

B Ifyou edit a photo published to a free
Flickr account, changes won't be reflected
in Flickr automatically, at least in iPhoto
8.0.2. To get the image to be updated
on Flickr, delete it from the Flickr Web
album in iPhoto and add it back again.

m Keywords you add in iPhoto are automat-
ically uploaded to Flickr as tags. There’s
no way to prevent that in iPhoto.

B Contacts on Flickr can be identified as
“friends” or “family” for interaction with
the Photos Viewable By pop-up menu.

B Each Flickr Web album corresponds with
a photo set on Flickr; you cannot upload
loose photos to your photostream in
Flickr.
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Publishing Photos on the Web

Figure 8.16 iPhoto provides feedback on what it’s
doing in the upper right corner of the screen.

¥ MOBILEME GALLERY
E'Adm Running the Ithaca...
F Grandma Estelle's Apart...
¥ Seattle Pigs (49) &
Desktops (65) ®
¥ High Noon/FLRC Phatos (7).
¥ Boris & The Woodchuck (2)
F{ Triennial 2008 Finish Ph... €3

¥ FACEBOOK
I3 Glenn Photos @) i Figure 8.17 When
me Pigs (10) | iPhoto is synchronizing
'Fli:ijm a Web album, it shows
*+| Conwy Castle (5}

aspinning progress
icon.

-
[#+] Beaumaris, Caernarfon, ... &

album “Grandma Estelle’s Apartment™?

The album contains photos that were downloaded from your
MobileMe Gallery. Downloaded photos that have not been imported will
be moved to the Trash unless you choose 1o import them,

‘ a Are you sure you want to stop publishing and delete the

) import photos to your library before deleting this album.
(cancel ) (e

Figure 8.18 When you delete a Web album, iPhoto
warns you if it contains any photos downloaded from
the Web side and gives you a chance to import them.
If the Web album contains only photos that originated
in iPhoto, the dialog reassures you that deleting the
Web album won't affect your original photos.

Facebook and Flickr Flakiness

As of iPhoto 8.0.2, I've experienced flaky
behavior in a number of areas.

¢ Most annoyingly, Facebook tags often
failed to link to my friends” accounts
reliably, even when I knew the appro-
priate email address to enter.

¢ Changed names and keywords in
one location sometimes failed to be
reflected on the other.

¢ Although both Facebook and Flickr
support movies, you can neither
upload nor download movies in Web
albums. [nstead, you just get an image
placeholder.

Managing Web Albums

The beauty of Web albums, whether
uploaded to MobileMe, Facebook, or Flickr, is
that they aren’t static. You can modify their
contents in iPhoto, or you or others can add
photos to them or change names and tags on
the Web side. Either way, iPhoto keeps both
versions in sync.

To add photos to a Web album:

+ Select one or more photos, and drag them
to the desired Web album.
iPhoto processes and uploads the photos,
providing the status in the upper-right
corner of the screen (Figure 8.16).

To remove photos from a Web album:

¢ Select one or more photos in the Web
album and press (Delete).
iPhoto removes the photos, updating the
files on the Web version and showing a
spinning progress icon next to the album
while that’s happening (Figure 8.17).

To start or stop synchronization:

¢ (Click the little status icon next to the
Web album name in the source pane.

If the icon shows radio waves, iPhoto
starts synchronizing.

If synchronization was interrupted, the
icon changes to an exclamation point.
Click it again to resume updates.

To delete a Web album:

¢ Select a Web album in the source pane
and press [Delete).
iPhoto asks for confirmation and then
deletes the Web album and the photos
on the Web, leaving the originals in
iPhoto alone and offering to import any
photos that were added on the Web side
of MobileMe, Facebook, or Flickr and
downloaded to iPhoto (Figure 8.18).
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PUBLISHING PHOTO PAGES WITH iWEB

Chapter 8

Publishing Photo
Pages with iWeb

iPhoto's integration with iWeb is similar to
its integration with iDVD: it just hands off
selected photos. You can create two types
of pages when starting from within iPhoto:
photo pages and blog pages.

To publish a photo page:

1. Select an event, album, or the individual
photos you wish to publish.

2. From the Share menu'’s Send to iWeb
submenu or the iWeb pop-up menu in
the toolbar, choose Photo Page.

iPhoto launches iWeb, creates a new
page, and asks you to select a template.

3. Select a template and click Choose.
iWeb imports the photos and presents
you with a page that simulates your even-
tual photo Web page (Figure 8.19).

4, Edit the various text blocks for the page
name, description, and photo titles as
desired (click a block twice to edit it).

5. Click any photo to show the Photo Grid
window, from which you can choose a
variety of display options.

6. Click the site’s top icon in the sidebar to
view the site’s Site Publishing Settings
pane. From the Publish To pop-up menu
choose MobileMe, FTP Server, or Local
Folder (Figure 8.20). Enter connection
details and click the Publish Site button.

v Tips

B For full details about iWeb, see Steve
Sande's Take Control of iWeb 09 at
www . takecontrolbooks. com/iweb.

W [t's best to give your photos titles in
iPhoto, rather than in iWeb, to avoid
duplicating effort later in iPhoto.

—-—— ——

Figure 8.19 In iWeb, edit the text blocks that name
and describe your page, and choose styles for the
photos from the Photo Grid window.

Site Publishing Settings
Publishing
Publish 1o |ETP Sawwe, - 2

Publish to & web hosting service.

Sive name: [Wales Trip ]

Contact amalt: [acetidbits.com

FTP Server Settings
Sarver addraas: [p tidbis com ]

User name: [meuplcad ]
Password: [ssssssasss ]
Directory/Path: | /cersanal jadam |
LT T S
| Test Connecton | @

Website URL

URL: [hetp 7w tidboes com / ]

Your site’s root URL. Used for creating ks and RSS feecs.

Facebook®

1 Update my Facabook profle whas | publih this site.

Figure 8.20 In the Site Publishing Settings pane,
enter the connection details for the site to which
you're uploading your photos.

iWeb Upload Choices

You have three site publishing choices:

¢ MobileMe is the easiest and most full-
featured, but does cost $99 per year.

® FTP Server lets you work with almost
any other Web server that allows
uploads via FTP or one of its variants.

¢ Local Folder is available if you can’t
use one of the other methods.
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Publishing Photos on the Web

Figure 8.21 When you send a photo to an iWeb blog,
iWeb creates a new entry for the photo.
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Figure 8.22 iWeb automatically updates the main
page for your blog once you've entered details for a
specific blog entry.

More Features in iWeb

Documenting all that iWeb can do is way
beyond the scope of this book, but note
that there are many other things it can do:

® You can put a Google Map widget on
the page, showing exactly where pho-
tos were taken.

¢ Ifyou've uploaded albums to your
MobileMe Gallery, another widget lets
you display a clickable thumbnail for
that album on your Web site.

¢ By default, iWeb adds an RSS feed and
a search field to your blog, though you
can remove those if you wish.

Publishing Blog
Photos with iWeb

Whereas a photo page looks much as you'd
expect a Web photo album to look, a photo
blog features a single photo per chronologi-
cal entry.

To publish a photo to an iWeb blog:

1.

Select a photo, and from the Share menu’s
Send to iWeb submenu or the iWeb pop-
up menu in the toolbar, choose Blog,

iPhoto launches iWeb and creates a new
blog entry (Figure 8.21).

Edit the various text blocks for the blog
post title and description as desired (click
a block twice to edit it).

iWeb automatically updates the main
page for your blog as well (Figure 8.22).
Note that you can change the listing style
in the Blog Summary window.

Click the site’s top icon in the sidebar to
view the site’s Site Publishing Settings
pane. From the Publish To pop-up menu
choose MobileMe, FTP Server, or Local
Folder (Figure 8.20, previous page).
Enter connection details and click the
Publish Site button.

v Tips

Your iWeb blog can be on the same site as
your photo pages or another site.

You can drag photos from iPhoto into
various spots in iWeb, either into a page
for free placement of the photo, or into
one of iWeb’s image placeholders. This
may be easier than using iWeb’s media
browser pane.

Double-click any photo in iWeb to resize
it within its placeholder.
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EXPORTING TO WEB PAGES

Chapter 8

Exporting to Web Pages

Although iWeb can create Web pages you
can upload to your own server, iPhoto has a
built-in way of doing this that’s simple and
effective, even if its results aren’t as visually
interesting. (Honestly, use iWeby; it's better.)

To export photos to Web pages:

1. Select an album or the individual photos
you wish to publish via the Web.

2. Choose Export from the File menu
((Cmd(Shit)E)).
iPhoto shows the Export Photos dialog.

3. Ifit's not selected, click the Web Page
button (Figure 8.23).

4. Enter the title for your Web page.

5. Enter the desired number of columns
and rows of photo thumbnails.

6. Ifdesired, choose a template and select
background and text colors.

7. Enter the maximum width and height
for the thumbnails and the full-size
images.

8. Select the Show Title, Show Description,
Show Metadata, and Include Location
checkboxes as desired.

9. Click Export, navigate to the desired
destination folder (it’s best to create a
new folder inside your user directory’s
Sites folder), and click OK.
iPhoto exports the photos and builds
the appropriate HTML files.

10. Switch to the Finder, open the folder in
which you saved your Web page, and
double-click the index.html file to open
it in your Web browser (Figure 8.24).

11. Ifnecessary, upload the folder to your
Web site using an FTP program like
Fetch (www. fetchsoftworks.com).

———{_File Expor_|~WebPape- QuickTime™ _ Siideshow }
Page
Title: [ 11 Mile Run on 11/11/07 at 11:12.11 |
Columns: 3 Rows: |10 1 Page
Tamplae:
Background: [ Text Color. ||
Thumbnail Jm
Max width; 240 | Max width: 640 |
Max height: 240 Max height: 640 |
™ show title # Show title
1 Show description [ Show description
|_!Show metadata

[include lacatian

(o) (o)

Figure 8.23 Use the options in the Web Page pane of
the Export Photos dialog to set how your photos will
appear on the Web page.

9 items

Figure 8.24 To see your Web page, open the destina-
tion folder in the Finder and double-click the .html file
in it. To expand a photo, click its thumbnail.

Managing Plug-ins

To manage plug-ins, select iPhoto in the
Finder, choose Get Info ([Cmd][1]) from the
File menu, and use the checkboxes and
buttons in the Plug-ins section to enable,
disable, install, and uninstall the plug-ins.
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Picasa Web Albums Uploader for Mac by
Google; free. Helps you upload to Picasa
Web albums. http://picasa.google.
com/mac_tools.html

Kodak Gallery Upload Plug-in by Kodak;
free. Provides access to the Kodak Gallery
photo-sharing site. www . kodak . com/
eknec/PageQuerier. jhtml?pg-path=150

SmugMugExport by Aaron Evans; free.
Uploader for the SmugMug photo site.
Www.aarone.org/smugmugexport/

locr for iPhoto by Norbert Doerner; free.
Uploads geotagged photos to locr, a
location-based photo-sharing site.

www. locr. com/downloads#iphoto

UberUpload for iPhoto by Ubermind;
$19.95. Uploads to FTP and SFTP servers,
with many options. www.ubermind. com/
products/uberuploadforiphoto.php

PhotoUpLink for iPhoto by Mark Morris;
$12.99. Uploads to FTP sites, databases,
and Office 2004. www . photouplink.com

Flash Album Exporter from Ken Welch;

free. Creates album pages using freeware
Flash and JavaScript apps. http://home.
comcast.net/~flashalbumexporter/

BetterHTMLExport from Geeks R Us;
$20. Makes better static Web pages than
iPhoto’s built-in export. www.geeksrus.
com/software/betterhtmlexport/

iPhotoToGallery by Zach Wily; free.
Makes it easier to export to Gallery-
driven Web sites. waw.zwily. com/iphoto/

PictureSync by Holocore; $10. Standalone
application that uploads to many Web
services. www.picturesync.net

iPhotoWebShare by bitpatterns; $5. Easy
to use preference pane that serves iPhoto
albums directly. www.bitpatterns.com/
site/iPhotoWebShare/

Other Web Export Tools

Developers can build iPhoto export plug-ins
for other photo-sharing sites and for generat-
ing Web-based albums. I can’t list them all,
but this collection will get you started.

For more utilities, search for “iPhoto” on
VersionTracker at www. versiontracker. com
and check the iPhoto Plugins News blog at
http://wheezersociety.blogs.com/iphoto_
plugins/.

Make sure any plug-in you download has
been updated for iPhoto 09 before installing;
not all of these have been updated yet!

Useful Web export tools for iPhoto:

¢ FlickrExport by Fraser Speirs; £12. Full-
featured export plug-in for uploading to
Flickr. Try it if iPhoto’s Flickr support isn't
sufficient. http://connectedflow. com/
flickrexport/iphoto/

¢ iP2F by Tagtraum Industries; $14.95.
Another export plug-in for uploading
to Flickr. www. tagtraum.com/ip2f.html

¢ Facebook Exparter for iPhoto; free.
Predates iPhoto’s Facebook support,
but may be worth trying. http://
developers.facebook.com/iphoto/

¢ PixelPipe for iPhoto by PixelPipe; free.
An export plug-in for sending photos to
the PixelPipe media distribution service.
http://pixelpipe.com/

¢ Shutterfly Export Assistant for iPhoto
by Shutterfly; free. Simplifies upload-
ing to Shutterfly. waw. shutterfly.com/
downloads/features_mac.jsp

¢ iPhoto to Picasa Web Albums by
Ubermind; $19.95. Uploader for Picasa
Web albums with support for geotagged
photos and more. www. ubermind. com/
products/iphototopicasawebalbums.php
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SuBScRIBING TO WEB PHOTO FEEDS

Chapter 8

Subscribing to
Web Photo Feeds

Although this chapter has been about
publishing photos to the Web, you can also
subscribe to photos that have been published
on either MobileMe or any other Web site
with an RSS feed. This displays the photos

in iPhoto, where you can do anything with
them other than edit, burn to disc, or add to
a Web album.

To subscribe to a MobileMe Gallery:

1. Inyour Web browser, navigate to the
MobileMe Gallery that you want to
subscribe to and, if you want to subscribe
only to a particular album, go into that
album (Figure 8.25).

2. Click the Subscribe button at the top of
the screen, and in the dialog that appears,
select iPhoto and click OK (Figure 8.26).

iPhoto comes to the front and the Web
album is added in your Subscriptions list
in the source pane (Figure 8.27).

To subscribe to other Web albums:

1. Onthe Web site containing the photos
you want to subscribe to, look for an RSS
button or link, [Contral]-click it, and choose
Copy Link.

2. IniPhoto, choose Subscribe to Photo
Feed ((Cmd][U)) from the File menu.

iPhoto shows the photo feed address
dialog.

3. Paste your previously copied URL and
click the Subscribe button.

iPhoto adds the album to the
Subscriptions list in the source pane.

v Tip

® To unsubscribe from a photo feed, delete
its album from the Subscriptions list.

Figure 8.25 To subscribe to a MobileMe Gallery
album in iPhoto, click the Subscribe button.

Subscribe
s S b e g W G o S
£) e
e p griare S T -
.3 " Pogte TR i frr— T v g 0 e T
C—

G e

Figure 8.26 Select iPhoto to subscribe to the feed in
iPhoto, as opposed to another RSS reader.

Figure 8.27 Subscribed photo feeds appear in the
Subscriptions list in the source pane.

v’ More Tips

B IfiPhoto doesn’t download photos from
a new feed right away, quit and relaunch.

B Ifyou delete a photo feed, iPhoto prompts
you to import the subscribed photos.

B Tosubscribe to a better Flickr feed with
more, larger photos, use Photocastr at
http://photocastr.quantumfoam.org/.
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SHARING
PHOTOS

Although iPhoto provides numerous ways
of presenting your photos to others—slide-
shows, publishing to the Web, and (coming
up in the next chapter), creating books,
calendars, and cards—there’s an additional
way in which you can share photos in iPhoto
that’s also important.

I'm talking about the sharing of the actual
photo files. For instance, you might want to
share photos with a family member who also
uses your Mac, or a roommate whose Mac

is on your network. Or maybe you want to
send photos to friends via email or on a CD
or DVD. iPhoto can help in all of these situa-
tions and more. I've organized this chapter in
roughly that order; think of it as near (shar-
ing on your Mac) to far (sendinga CD to a
Windows-using relative or using email).

Keep in mind that although Apple has pro-
vided various different tools for sharing these
original photos, there are usually trade-offs.
For instance, it's trickier to burn a CD of
photos for someone who uses Windows than
for someone who uses iPhoto on the Mac.
And although iPhoto has one built-in way for
people on the same Mac or multiple Macs to
share photos in their iPhoto libraries, Apple
still hasn't done anything in iPhoto’s inter-
face to make it easy for people to share the
same iPhoto Library package.
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SHARING A LIBRARY ON THE SAME MAC

Chapter g

Sharing a Library
on the Same Mac

Mac OS X is a multiuser operating system, so
it's common for people who share a Mac each
to have an account. But what if you want to
share the same iPhoto Library among mul-
tiple users on the same Mac?

To share your library among users:

1. With iPhoto not running, rename your
iPhoto Library to iPhoto Shared Library
(to avoid confusion) and move it from
the Pictures folder to the Shared folder
at the same level as your user folder
(Figure 9.1). The Shared folder may
or may not contain other items.

2. Double-click the iPhoto Shared Library
to open it in iPhoto and verify that it's OK.
Quit iPhoto.
iPhoto may display a dialog asking you
to select the library; the one you double-
clicked will be selected, so click Choose
(Figure 9.2).

3. Switch to the other user via Fast User
Switching and double-click the iPhoto
Shared Library to open it and make it
the default.
iPhoto may display the dialog asking you
to select the library again; the one you
double-clicked will be selected. so click
Choose (Figure 9.2).
iPhoto displays a dialog asking you to
repair permissions (Figure 9.3).

4. Click the Repair button.

5. For each additional account, repeat steps
3and 4.

6. From now on, each user on your Mac
should launch iPhoto normally by click-
ing iPhoto in the Dock or by double-click-
ing the iPhoto Shared Library package.

Figure 9.1 Store your iPhoto Shared Library in the
Shared folder at the same level as your user folder.

find another library on your computer, or create a new library that
¥ou can import photos to later. The same photo libtary will be used
the next time you open i¥hoto.

g . What photo library do you want IPhoto to use?
| To apen, iPhota needs a photo library. Select a library from the Iist,

iPhoto Library WW

iPhoto Library_2
iPhoto Shared Library (delault)
{Users/Shared/IPhoto Shared Library
( Otertiary ) (oo ) i)

Figure 9.2 The first time you double-click the iPhoto
Shared Library in the Shared folder from each
account, iPhoto may prompt you to select it (it should
be selected by default). Click the Choose button to
proceed.

Caution

The iPhoto Library is locked, on a locked disk, or you
do nat have permicsion to make changes to it
IPhotu can try to repair the permissions.

€ Repair ) (R

Figure 9.3 The first time you open the iPhoto Shared
Library in the second account, iPhoto prompts you to
repair the permissions. Click Repair.
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Figure 9.4 If you don’t want to give everyone your
user name and password to connect to your Mac, use
the Sharing preferences pane to share the Pictures
folder and set up login accounts for everyone.
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tom Wom oo ot

ot s () Gt
B g s

Figure 9.5 Select the host Mac in the sidebar and
then click Connect As to connect to the shared
Pictures folder.

Network Sharing Decisions

Use the network sharing method on this
page to share an entire iPhoto Library and
have each person make changes that are
seen by every other person. This method
let you share the work of editing photos,
making albums, and assigning keywords.

Use iPhoto’s photo-sharing approach,
discussed on the next page, to let other
people see and potentially copy your pho-
tos without making any other changes.
This approach works best when each
person has his or her own primary collec-
tion of photos but wants to access a few
photos from other people.

Sharing a Library
among Multiple Macs

You can also share an iPhoto Library across a
netwark from a Mac with file sharing turned
on, or via an external hard drive. If you're
using a network, the faster the better (ideally
wired gigabit Ethernet or 802.11n AirPort
Extreme).

To share your library over a network:

1. Inthe System Preferences Sharing pane
on the host Mac, turn on File Sharing.
Either give the other people your user
name and password, or add the Pictures
folder to the Shared Folders list, set up
user names and passwords for them
using the + buttons, and give them Read
& Write access (Figure 9.4).

2. From each remote Mac, connect to the
host Mac by clicking it in the sidebar,
clicking Connect As, and entering the
user name and password (Figure 9.5).

3. For each user, double-click the iPhoto
Library in the shared Pictures folder.

To share your library on a drive:

1. Select the drive in the Finder, choose Get
Info ([€md](1)) from the File menu, and,
in the Ownership & Permissions area at
the bottom of the Get Info window, select
Ignore Ownership on This Volume.

2. With iPhoto not running, copy your
iPhoto Library from the Pictures folder to
where you want it on the shared volume
and rename it iPhoto Shared Library.

3. Foreach user, double-click the iPhoto
Shared Library on the shared volume.

v Tip

B Only one person may use the shared
iPhoto Library at a time.
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SHARING PHOTOS VIA iPHOTO SHARING

Chapter g

Sharing Photos
via iPhoto Sharing

iPhoto enables you to share all your photos,
or just individual albums, with other iPhoto
users on your Mac or on your network.

To share photos via iPhoto Sharing:

1. From the iPhoto menu, choose

Preferences ((Cmd), J) and click the
Sharing button.

iPhoto displays the Sharing preferences
(Figure 9.6).

2. Select Share My Photos, and then select
either Share Entire Library or Share
Selected Albums.

3. Ifyou selected Share Selected Albums,
select the albums you want to share in
the list below (Figure 9.7).

4. Inthe Shared Name field, enter a name
for the shared folder under which your
photos will appear for other users on your
Mac and network.

5. Ifyou want to restrict access to your
shared photos, enter a password in the
Require Password field. You'll then have
to give that password to approved users
(Figure 9.7).

6. Close the Preferences window.
v Tips

W Amazingly, iPhoto 8.0.2 cannot share
movies in an iPhoto library via network
sharing. They simply don't appeatr.

B iPhoto sharing also works between users
of the same Mac, when both are logged
in via Fast User Switching; leave iPhoto
running when switching accounts.

B iPhoto automatically selects the Require
Password checkbox when you type the
password for the first time.

W ook for shared photos
# Share my photos

@ Share entire library

() Share selected albums:

" Photos
| Last 12 Months
I Last Import
"1 IPhote VOS5 Phutos
| Externalized Photas Ir

Shared name: | Adam Engst's Library

[ Require password: |
Statws: On

Figure 9.6 Turn on photo sharing in the Sharing pane
of iPhoto’s Preferences window.

M Luok for shared photos
™ Share my photos
() Share antire library
® Share selected albums:

|| Screensaver (All Photos)
™ Rest of Tristan

| | Borls's Friends' Fireworks .
# Rostan 2004 |

'™ My Favorites (4-5 Stars) E

Shared name: | Adam Engst's Library

™ Require password: | sesss |
Stawus: On

Figure 9.7 You can restrict shared photos to specific
albums, and you can require that users enter a pass-
word to access your shared photos.

Turning off Sharing

To turn off photo sharing, simply deselect
the Share My Photos checkbox in the
Sharing pane of iPhoto’s Preferences win-
dow. If anyone is currently connected to
your photos, iPhoto asks if you're sure you
want to turn off photo sharing first.

I recommend you either do this or set

a password before taking a laptop on a
trip, or anyone with iPhoto on a hotel or
hotspot network will be able to see and
copy your photos!
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Accessing Shared Photos

Working with shared photos is similar to
using an iPhoto disc (see “Importing from
an iPhoto Disc,” on page 17).
To access shared photos:
1. Make sure the Mac with the shared
photos has iPhoto launched and photo
blend sharing turned on.
2. Onthe Mac or in the account from which
0 Frowes Book (Smat) ¢43) ;
Win1s 200000 e you want to access the shared photos
{4 quick spinmwssgh 20 [l] Shared photosin the : : :
W mizaeipna irp 2007 1) Ml Shares list in the source launch iPhoto, and from the iPhoto
gm R P click the shared menu, choose Preferences ([Cmd)(,)) and
G Fai Leaves 2007 36) photo library to load it, click the Sharing button.
B 5F -Saatte’ fris (A57) and click the expansion ) ) ]
s seame TrpBookioel | | triangle to the left to iPhoto displays the Sharing preferences.
& Tonva's Valearines (10) display its albums. )
3. Make sure Look for Shared Photos is
selected (Figure 9.6, previous page).
4, Close the Preferences window.
Actions Allowed In the source pane, iPhoto displays the
for Shared Photos shared library in the Shares list.
ry
Just because you can see shared albums 5. Click the shared library to load it. If the
in your source pane doesn’t mean you can shared photos are protected by a pass-
do everything with their contents that word, enter it when prompted.
you can do with your own photos. iPhoto loads the shared photos, display-
You can copy shared photos and albums ing individual albums underneath the
to your library or albums, play a basic s%nared‘hbriary vxjhen you click its expan-
slideshow with shared photos, and send sion triangle (Figure 9.8)
shared photos to others via email. v Tips
YO'-_‘ cannot edit shared Photos in any way, B If more than one copy of iPhoto on your
assign keywords and ratings, get much network is sharing photos, iPhoto creates
photo info, make a new album, use a a Shared Photos folder and puts all the
shared album to create a book, print pho- shared libraries inside it.
tos, put shared photos on your Desktop )
or use them as your screen saver, make an W Todisconnect from a shared photo
DD Slicdes hanw. Dirn thern to disersend album, click the little eject button next
them to iWeb, or export them in any way. to its name in the source pane.
B Toimport all the photos in a shared

Basically, you can only view shared pho-
tos; for any action that requires making
changes, you must first copy the photos
to your Mac.

album, drag it to another spot in the
source pane.
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EXPORTING FILES

Chapter g

Exporting Files

iPhoto’s export capabilities offer the features
most people need.

To export files:

1. Select one or more photos, and choose
Export from the File menu (([Cmd]Shift) E]).
iPhoto displays the Export Photos dialog
(Figure 9.9).

2. Click the File Export button.

3. Choose the format for the exported
photos from the Kind pop-up menu, set
JPEG compression if necessary, choose
an image size, and set up how you want
them named. Then click Export.

4, iPhoto displays a Save dialog. Navigate to
your desired folder and click OK.

v Tips

® iPhoto can export into only JPEG, TIFF,
and PNG formats. For other formats, use
GraphicConverter (www. Lemkesoft . com).

B For JPEG format, you can set the quality.
The higher the quality, the larger the file.

B Select the Title and Keywords checkbox
to export that information to the file’s
IPTC tags, enabling other applications
to read photo titles and keywords from

iPhoto. It works only with JPEG and TIFF.

B When iPhoto scales an image, it does so
proportionally with the limits you set.

W Use Original in the Kind pop-up menu
to export a RAW file, GIF file, or other
file format that iPhoto converts to JPEG
when edited. Current exports the cur-
rent format of such photos, without any
options to scale them.

W Select the Location Information
checkbox to export geotags with the
file's EXIF tags, in JPEG or TIFF format.

Wl gt Web Pagr  QuickTime™  Slideshow b
Kind: | JPEG 2
JPEC Quality: | Maximum 2]
Include; ¥ Title and keywords
# Loeatian information
size: | Custom =2
Max
of 2000 |pX
- Am
File Name: | Sequential “#
Prefix for sequential lnxpon'd-imaqn l
4 items. E

Figure 9.9 Use the File Export pane in the Export
Photos dialog to set various options for your
exported images.

File Naming Choices

When naming exported files, you can

use the title, filename, the album name
(with a sequential number automati-
cally appended). or your own name with
sequential numbers appended. When
exporting files for use on other plat-
forms, it's best to avoid title and album
names that could include spaces or other
troublesome characters.

Size Names and Numbers

Annoyingly, iPhoto doesn’t provide the
actual numbers that correspond to the
items in the Size menu, Here they are:

¢ Small = 320 x 240
¢ Medium = 640 x 480
¢ Large= 1280 x960
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|1 Exported Photos

(@00
==

0 items, 5.81 GB available

Figure 9.10 For a quick export without any chance to
reformat, rename, or resize the exported photos, just

drag one or more to the Finder.

(@06 |3 Exported Photas
32z 3 items, 5.81 GB available
e
IMG_9498JPC
e e
IMG_9493,JPC IMG_9500.,JPC

Figure 9.11 iPhoto copies the files from its Modified
folder (or the Originals folder if the files haven’t been

edited in any way) to the destination folder in the
Finder,

Exporting
Files by Dragging

If you just want copies of a couple of photos
and don't need to reformat or resize them,
you can just drag the files to the Finder.

To export multiple files:

*

Select one or more photos and drag
the selection to a folder in the Finder
(Figure 9.10).

iPhoto saves the files where you drop
them, using each file's original name
(Figure 9.11).

v Tips

With a drag-export, iPhoto is literally
copying the files from its Modified (for
edited photos) and Originals (for photos
you haven't touched) folders to the des-
tination folder in the Finder. See “iPhoto
Directory Structure,” on page 19.

(Option}-drag a photo from iPhoto to the
Finder to export the original file rather
than the edited version.

When you drag photos to export them,
you aren’t given the opportunity to
change their scale or image format.

You can also drag photos to other photo-
related programs. This is not actually
exporting, since the other program is
working with the same file as iPhoto.
Because of this, don't drag files to image-
editing programs and make changes,
because iPhoto won't be able to track
those changes (see "Using an External
Editor,” on page 110). And definitely don’t
delete photos from those other programs!

Unfortunately, you can’t drag an album
to the Finder to create a new folder that
contains the album’s photos.
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Chapter g

Sharing Photos on
Disc with iPhoto Users

If you want to share a lot of photos with a
friend or family member, burning a CD or
DVD to send to your recipient works best.

To burn an iPhoto disc:

1. Select the items you want to burn, which
is best done by selecting entire events,
folders, albums, books, or slideshows
(Figure 9.12).

2. From the Share menu, choose Burn (or
click the toolbar’s Burn button), insert a
blank disc if prompted, and click OK.

Below the display pane, iPhoto shows the
name of the disc and information about
how much data will be burned to the disc
(Figure 9.13). The disc icon will be red if
it can’t hold the selected photos.

3. Select fewer or more photos to use the
space on your destination disc as desired.

4. Change the name of the disc if you want.

5. When everything looks right, click the
Burn button (on the far-right side of
Figure 9.13) to start the burn, and when
iPhoto asks you to confirm one last
time and lets you set additional burning
options, click Burn (Figure 9.14).
iPhoto creates a disk image, copies the
selected photos to it, and burns the disc.

v Tips

m Ifyou select albums to burn, the iPhoto
disc retains those album references.
Event information is lost, however.

B Your disc name appears in both iPhoto
and the Finder.

B On the disc, your photos are stored in
an iPhoto Library folder, not an iPhoto
Library package.

= AMmMeaxl &

s e -
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Erlmfinilaw
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Figure 9.12 To get started, select the items you want
to burn in the source pane, choose Burn from the
Share menu, and then insert a blank disc.

[ - e e e y —
— : -—— S e

Figure 9.13 Once you've inserted the disc, iPhoto lets
you name your disc and gives you information about
how much data will be burned to it.

Burn Disc In: SuperDrive B
L | Burning 378 photos out of 2 total of 437 phetas,

Burn Options
Speed:  Ax
T Erase disc bafore burning
_!Leave disc appendable

After Burni g
4 Verify burned data
(O Eject disc ) Mount on Desktop

Clea) (ool i)

Figure 9.14 iPhoto verifies that you really want to
burn a disc with one last dialog that also provides
additional burn options if you click the triangle
button in the upper-right corner.

Receiving an iPhoto Disc

If someone sends you an iPhoto disc,
you can browse the photos on it directly;
to import them see “Importing from an
iPhoto Disc,” on page 17.
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You inserted a blank CD. Choose an action
from the pop up menu or click Ignore.

Action: ( & Open Finder ﬁ

1 Make this action the default

@ (tieer ) (lgnore ) o)

Figure 9.15 Choose Open Finder from the Action pop-
up menu after you insert the blank disc.
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Figure 9.16 Export your photos to the disc, at
the bottom of the Save dialog’s sidebar.
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Figure 9.17 Click the Burn button in the disc’s Finder
window to start the burn.

| Are you sure you want 1o burn the contents of
“Hartshorne Photos” to a disc?

& You can use this disc on any Mac or Windows comnputer. To eject the
o dist withuout burning it, dick Eject.

Disc Name:  Hartshorne Photos

Burn Speed: | Maximum Possible (4x) 18]

() Save Burn Folder To.  Hartshorne Photos

(e ) (Camel) )

Figure 9.18 The Finder verifies the name and burn
speed before burning.

Sharing Photos on
Disc with Windows Users

Alas, not everyone uses a Mac or iPhoto, and
for these people you need to burn a normal
disc, rather than one with an iPhoto Library
folder on it.

To burn a disc for
use by non-iPhoto users:

1. Insertablank CD or DVD, choose Open
Finder from the Action pop-up menu
(Figure 9.15), and then give your disc
a name like any other volume.

2. IniPhoto, select a group of photos you
want to burn and export them directly to
the just-inserted disc, which appears at
the bottom of the sidebar in the Save dia-
log (see “Exporting Files,” on page 152). If
you wish, when saving the exported pho-
tos, click the New Folder button to create
anew folder for photos (Figure 9.16).

3. Repeat step 2 until you've exported all the
photos you wish to burn.

4. Inthe Finder, open the disc’s window to
verify it contains what you expect, click
the Burn button (Figure 9.17), and verify
the disc name and burn speed before
clicking Burn (Figure 9.18).

The Finder proceeds to burn the disc.

v Tips

B Choose Use Title from the File Name pop-
up menu when exporting so your photos
end up with the best possible filenames.

B Choose JPEG from the Kind pop-up menu
when exporting, unless you have a good
reason for choosing another format.

B [ necessary, open the CDs & DVDs
System Preferences pane and choose
Ask What to Do from the pop-up menus
related to inserting blank discs.
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EMAILING PHOTOS

Chapter g

Emailing Photos

For many people, email is the preferred
method of receiving photos from friends.

To configure iPhoto for email:

¢ Inthe General pane of iPhoto’s
Preferences window, choose your email
program from the Email Photos Using
pop-up menu (Figure 9.19).
iPhoto changes the toolbar’s Email button
to match the icon of your email program.

To send photos via email:
1. Select the photos you want to send.

2. Choose Email from the Share menu, or
click the Email button in the toolbar.

iPhoto displays a dialog with options for
your photos (Figure 9.20).

3. Choose the maximum size you want the
photos to appear from the Size pop-up
menu, and, if you want to include titles,
descriptions, and location information,
select their checkboxes.

4. Click the Compose Message button.

iPhoto exports the pictures (converting
them to JPEG), creates a new message,
and attaches the photos, which appear
inline only in Apple Mail (Figure 9.21).

v Tips

B Ifyou send too many photos, or don't
shrink their sizes enough, your message
may be too large to be delivered. Try to
keep the total amount under 4 MB.

B You can also drag photos from iPhoto
into some email programs, but that sends
the photos at full size.

B Tosend alot of photos via email, check
out the YouSendIt iPhoto plug-in, which
works with the YouSendlt service.
www . yousendit.com/cms/plugin-iphoto.

Sources: M show last [ 13)(3) months album

¥ Show irem counts

Double-click phato: © Fdits phora
) Magnifies photo

toae O € @9

America Online
i Eudora

Edit

Email photos usii

S W Mailplane
Connecting camera ope © Microsalt Entourage

# Check far IPhato updates automaically

Figure 9.19 In the General pane of iPhoto’s
Preferences, choose your email program from
the Email Photos Using pop-up menu.

Size: | Small (Faster Downloading) &4
Estimated size: 63 KB for 1 photo

Include: ™ Titles ™ Descriptions
™ Location information

( Cancel ) W

Figure 9.20 Make sure to set a reasonable size for
your photos before sending them via email or they’ll
take too long to transfer for you and your recipient.
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Figure 9.21 Here’s what the message looks
like in Mail. You don’t get much control over
the layout, but don’t worry, because there’s
no way of telling what it will look like on the
receiving end anyway.
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Gutenprint/Gimp-Print Drivers

What your printer can do is determined
by its driver, system-level software
provided by Apple or the manufacturer.
There’s also Gutenprint (formerly called
Gimp-Print), an open source set of driv-
ers for over 700 printers, which supports
options that the manufacturers may not
expose, such as printing on roll paper or
other unusual paper sizes. Learn more at:
http://gimp-print.sourceforge.net/
MacOSX. php.

How to Find Info in This Chapter

The iPhoto printing interface borrows
heavily from the interface used to create
books, cards, and calendars. As a result,
if you've created any of those items, you'll
be at home with creating prints. To avoid
duplication in this chapter, I first give an
overview of creating each type of keep-
sake, followed by details that are specific
to each (such as adding photos to dates
on a calendar), and then I finish up with
general instructions (such as how to enter
and edit text) that are common to all of
them.

If T had to pick a single feature that sets
iPhoto apart from most photo management
programs, I'd choose the way iPhoto enables
you to create professional-looking prints,
cards, calendars, and photo books—what
iPhoto '09 now calls “keepsakes.” Numerous
programs can help you edit and organize
photos. But iPhoto is the undisputed
champion of creating high-quality printed
products in an easy fashion.

The beauty of iPhoto’s prints, cards, calen-
dars, and books, apart from their quality
printing on heavy, glossy papet, is that they
help bridge the gap between the analog and
digital worlds. Many people still prefer prints
displayed in a traditional photo album, and
there's no denying the attraction of a glossy
color calendar on the wall that’s displaying
your photos or the slickness of a profession-
ally printed postcard showing your latest
photographic favorite on the front.

In addition, with a modern inkjet printer,
anyone can create prints that rival those
ordered from a commercial service.

Whatever your preference, by the time you're
done with this chapter, you'll be able to turn
your digital photography collection into
stunning prints, cards, books, and calendars.
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Chapter 10

Printing Photos Overview

Many people prefer to print their photos on
inexpensive color inkjet printers rather than
waiting for online orders.

To print photos:

1. Select one or more phatos to print and
choose Print from the File menu ((Cmd)P])
to bring up the print settings dialog
(Figure 10.1).

2. Select the desired theme from the list.

3. From the four pop-up menus, choose
the appropriate printer, printer-specific
presets, paper size, and print size.

4, Either click Print to print right away with
the default settings (jump to step 9), or
click Customize to switch to the print
project interface, which makes a Printing
album in the Recent list (Figure 10.2).

5. From the Themes, Background, Borders,
and Layout pop-up menus in the toolbar,
choose settings to lay out your photos.

6. Enter text if the layout provides it; you
can tweak text settings by clicking the
Settings button in the toolbar.

7. To make temporary adjustments to an
image, select it, click the Adjust button,
and use the buttons and sliders in the
Adjust window as you would in the nor-
mal Adjust and Effects windows in edit
mode (Figure 10.3).

8. When you're ready, click the Print button.

iPhoto displays the standard Mac OS X
Print dialog (Figure 10.7, on page 160).

9. Verify your printer and preset settings,
enter the number of copies to print, and
access other settings from the pop-up
menu under the page range controls.
Click Print when done.

iPhoto sends your photos to the printer.

: * Pageiold = (" Cumomize . )

Printar | Epvon Asutaser Papar Siza: | US Latter ]

Presats: | Phato on Photo Pazer 18] FrineSize: (Stansard 8
i Cancel )

Figure 10.1 Choose basic printing options in the
print settings dialog, and then click Print. Or click
Customize to set advanced options before printing.

= Dt 089

v A

Figure 10.2 In the print project interface, you can
choose alternate themes, backgrounds, borders, text
settings, and layouts, including those that put mul-
tiple photos on a single page.

Figure 10.3 Make
non-permanent
adjustments to pho-
tos using the modi-
fied Adjust window.
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Click to view  Click to view
page layouts. available photos.
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Figure 10.4 Choose the desired border design from
the Borders pop-up menu.

Figure 10.5 Choose the desired page layout from the
Layout pop-up menu.

Tle: (Ootima 4o (Reouisr (a4 [T4__ %)
Photos Per W—i Single photo per page- 3
Options: [ SM crop marks
™ Autoflow pages
( Restore Defaults ) (_cancel ) (oK)

Figure 10.6 Change settings for the entire print proj-
ect in the settings dialog.

Designing Print Projects

iPhoto enables you to print not just a

single photo at standard sizes, but also
multiple photos with themed frame styles,
colored backgrounds, and text. While you're
designing your prints, they appear in a
special Printing album in the Recent list in
the source pane; you can perform other tasks
and return to the Printing album at any time.

To design a print project:
1. Inthe print project, click a page.

2. From the Themes pop-up menu on the
toolbar, choose the desired theme (if
you want to switch from the currently
selected theme).

3. From the Background pop-up menu,
choose the color for your background.

4. From the Borders pop-up menu, choose
the desired border style (Figure 10.4).

5. From the Layout pop-up menu, choose
the desired page layout (Figure 10.5).

6. Click the photo icon to switch from view-
ing pages to viewing the available photos,
and then drag photos to the desired spots
in your layout.

7. Tweak each photo so it is zoomed and
centered appropriately; for details, see
“Editing Photos on Pages,” on page 176.

8. Enter text in any provided text boxes, and
change text settings as you would in any
other program.

9. Click an arrow button or press [ or
to move to another page, and repeat
steps 3-8.

v Tip

B Click Settings to change font settings for
all the pages of your print project, among
other options (Figure 10.6).
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PREVIEWING PRINTS

Chapter 10

Previewing Prints

Ink and paper for color inkjet printers are
expensive, particularly glossy photo paper.
If you're unsure about what'’s going to print,
it's best to preview the output before
committing it to expensive paper.

To preview prints:

1.

In the second Print dialog, choose Open
PDF in Preview from the PDF pop-up
menu (Figure 10.7).

iPhoto “prints” the selected photos

to a temporary PDF document called
“Untitled” and opens it in Apple’s Preview
application (Figure 10.8).

Click the thumbnails on the right side to
see other pages, and when you're done,
close the window or, if you like what you
see, click the Print button.

v Tips

If you click the blue triangle button in the
upper right of the Print dialog, it toggles
the Print dialog between contracted

and expanded states. In the contracted
state, there’s a Preview button that has
the same effect as choosing Open PDF in
Preview from the PDF pop-up menu.

You can save the temporary document

in the Preview application if you want

a PDF version, or just choose Save as PDF
from the Print dialog's PDF pop-up menu.

Previewing in this fashion won't help you
determine if your photos will fit within
the margins of your printer. Also, any
printer-specific changes you make in

the settings (such as forcing black ink

on a color printer) won't be reflected in
the preview. See if your printer has an
economy or draft mode you can use to
test printer-specific features on a single
page of photos.

Figure 10.7 Choose Open PDF in Preview from the PDF
pop-up menu to view your prints.

— = S T —

Figure 10.8 Your print preview opens in Preview.

Test, Test, Test!

A few things can affect how a photo looks
when it comes out of your printer:

¢ Printer capabilities, both what they
can do physically and what their driv-
ers allow, vary by brand and model.

# Inkjet printers print very differently
on different types of paper, and it's
important to match the print settings
to the type of paper you're using.

It may take several tries to determine the
best combination of options. You may
be able to try some in economy mode

on cheap paper, but in the end, you may
have to expend some ink on a few sheets
of expensive photo paper. To reduce the
waste and cost, keep good notes for sub-
sequent printing sessions.
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Paper Types

Computer superstores sell a vast number
of different types of inkjet papers. What
should you buy? You're almost certain to
get good results with paper made by the
manufacturer of your printer. Papers from
other manufacturers will likely work well
too, but aren’t as guaranteed. The basic
paper types include:

¢ Plain paper. Use it only for drafts or
text; photos won't look great.

¢ Matte paper. These papers are heavier
than plain paper and have a smooth,
but not glossy, finish. Matte paper can
be very good for photos.

¢ (Glossy photo paper and film. These
papers, which come in a bewilder-
ing variety of types and weights, are
heavier yet and have a glossy surface
that looks like standard photo paper.
Glossy film is actually polyethylene,
not paper. Use glossy paper for your
best prints.

@ Specialty papers. You can buy papers
that look like watercolor paper. have
a metallic sheen, are of archival qual-
ity, or are translucent. Other specialty
papers can be ironed onto T-shirts, are
pre-scored for folding, have magnetic
backing, and more.

If you like printing photos on your own
printer, I strongly encourage you to buy
a variety of papers and see what you like.
Also fun to try is a sample pack from Red
River Paper, an online paper vendor at
www.redrivercatalog. com.

Inkjet Printing Tips

How can you achieve the best quality prints?
Along with repeated testing, try these tips for
working with your photos and your printer:

*

Use a good quality inkjet printer. Printers
designed to print photos do a better job
than general-purpose printers (but may
not print text as well). Also consider dye-
sub printers, which are more expensive
but print wonderful colors. For printer
reviews, see www,printerville.net.

Make sure your print head is clean and
aligned. If your printouts don't look quite
right, try cleaning the print head.

Use good paper. Modern inkjets lay
down incredibly small drops of ink, and
standard paper absorbs those drops more
than photo paper, blurring printouts.

Make sure to print on the correct side of
the paper (it’s usually whiter or shinier).

Don’t handle the surface of the paper that
will be printed on. Oils from your skin can
mess up the printout.

Remove each sheet from the output tray
after printing, particularly with glossy
films, and be careful not to touch the
surface until it has dried.

In the Print dialog, make sure you're
using the highest resolution and other
appropriate settings. In particular, aim for
settings that favor quality over speed.

When printing black-and-white photos,
make sure to print with only black ink.
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Chapter 10

Printing Standard Prints

Printing standard print sizes on special
paper can be tricky, even in iPhoto.

To print standard print sizes:

1. In the print settings dialog, select the
Standard theme.

2. From the Paper Size pop-up menu,
choose the size that matches the paper
on which you're printing (Figure 10.9).

3. From the Print Size pop-up menu, choose
the size that matches how large you want
your photo to print (Figure 10.10).

4. If you wish to print multiple photos on a
page, click Customize, click Settings, and
choose from the Photos Per Page pop-up
menu (Figure 10.11). (Your print size
setting must be enough smaller than your
paper size setting.)

5. Click Print, and continue as normal.
An explanation of a tricky topic:

By choosing the paper size, you tell iPhoto
about the paper that the printer has loaded,
which may or may not be different from the
size of the photo you want to end up with.

[f you want to print on 4" x 6" paper, you
would choose 4 x 6 from the Paper Size
pop-up menu (the choices there are printer-
specific). But don’t choose a 4 x 6 print size.
Instead, choose Standard from the Print Size
pop-up menu to print the largest possible
area on the available paper.

In contrast, if you want two 5" x 7" photos on
the same 8.5" x 11" piece of photo paper so
you can cut them out, use US Letter for the
paper size, and set the print sizeto 5x 7.

v Tip

B Check Show Crop Marks in the settings
dialog to make it easier to cut out photos.
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Figure 10.9 When printing standard-sized prints, first
choose the paper size on which you’re printing from
the Paper Size pop-up menu.

Printar: | EPSON Stius Photo 570 PaparSizg  Sx7
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Figure 10.10 Then choose the desired print size from
the Print Size pop-up menu.
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Figure 10.11 To put more than one photo (either the
same one or different ones) on a page, choose the
desired option from the Photos Per Page pop-up
menu in the Settings dialog.

Photos Per P

Optio
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Figure 10.12 To print a contact sheet, select the
Contact Sheet theme, and click Customize.
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Figure 10.13 Set the number of columns with the
Columns slider.

Photo Info: [ Helvetica W (Reauiar W[ ™)

 Title # camera
1 Comments " shutter Speed
™ Date 1 Aperture
™ Rating T Focal Length
# Keywords 1150,
T Filename 1 Flash
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Figure 10.14 In the settings dialog, select which
pieces of metadata should print with the photos.

Printing Contact Sheets

Contact sheets are traditionally used to

look at a number of photos at once, which

is handy for comparing different versions of
the same picture, or for letting relatives who
don't have a computer pick which photos
they'd like you to order for them as prints.
Printing contact sheets is a bit different from
other types of prints.

To print contact sheets:

1. Select a number of photos, and choose

Print from the File menu ([Cmd)(P)) to
display the print settings dialog.

2. In the print settings dialog, select the
Contact Sheet theme (Figure 10.12), and
click Customize.

3. Inthe toolbar, select the desired number
of columns from the Columns slider, and,
if necessary, zoom photos in their frames
(Figure 10.13).

4. Click the Settings button in the toolbar,
and in the settings dialog choose the
items you want to print under each
photo, along with the font options
(Figure 10.14).

v Tips

B To print multiple copies of the same
photo, don’t use the Contact Sheet theme.
Instead, select Standard, choose the
desired size from the Print Size pop-up
menu, click Customize, click Settings,
choose Multiple of the Same Photo Per
Page, and click OK. (You may need to
enter a custom size: remember that your
photos are likely a 4 x 3 aspect ratio.)

B The maximum number of photos that
can print across the page is 10; that gives
you 13 rows for a total of 130 pictures.
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SETTING UP AN APPLE ID

Chapter 10

Setting up an Apple ID

Before you can order anything from Apple,
you must have an Apple 1D with 1-Click
ordering enabled. If you haven't previously
set up an Apple ID, you can create one within
iPhoto.

To set up an Apple ID:

1.

2,

Click the Order Prints button to display
the Order Prints window.

Click the Set Up Account button.

iPhoto displays the Apple Account
Sign-in dialog (Figure 10.15).

Click the Create Account button.

iPhoto displays the first of three dialogs
that collect the data necessary to create
an account (Figure 10.16). The first asks
for your email address and password, the
second collects billing information, and
the third garners shipping information.

Enter the necessary information, clicking
the Step button to move through the
process until you're done.

v Tips

If the Order Prints button isn’t show-
ing, choose Order Prints from the View
menu's Show in Toolbar submenu.

Remember that your Apple ID is always
your email address.

Choose a password that can't be easily
guessed. Otherwise miscreants could go
in, change your shipping settings, order
prints or books with your credit card, and
switch back without you realizing.

If you have trouble with your Apple ID,
visit http://myinfo.apple.com/ and
confirm or re-enter your settings. You
can also set up an Apple ID at this site
if necessary.

Apple Account Sign-in
To contunus with wour Srder. enter an Acpie 1D and Prtaward. M vou dont hise an Acple
MIGUTL Creaty one.
(Cruate Account ) . 0L I
( tearnMore ) | Passweed: Fargor Patmeond?
FSgmin)

Figure 10.15 To create a new Apple ID, click the Set Up

Account button in the Order Prints window to bring
up the Apple Account Sign-in dialog. Then click the
Create Account button.

Step 1 of 3: Create an Apple Account
Flease onter the fofiommg information 1 oreate your mew Agole account,

N ——

© This must be at least 6 characiers.

j Retype your pasyword.

& securt Conmaction

Entes & question and anveer Ihat you can easily remember to help
s werily your [dentity in case you Fargel your password,

Tuestian:
Answer:

Please enter youl date of birth,

Month: | B oy ! 2]

I st ke b revissve Apite s, Loftwars updiates, spenal alters, and

DO PULATED IRkt AD0 LOACH ITEm OEMeY SOMBARYS. hitondeicid

@ Came) (o)

Figure 10.16 Enter your sign-in information, billing
details, and shipping address in the dialogs that
appear.

Strong Passwords

Apple requires that your password be

at least six characters long, but you can
make it stronger by ensuring that it
contains numbers and punctuation along
with uppercase and lowercase letters. One
good strategy is to take a phrase you'll
remember, like “Take me out to the ball
game!” and use the first letter of each
word, adding numbers where possible.
The above phrase could be turned into
this strong password: Tmo2tbg!

Whatever you choose, do not use a proper
name or a word that will appear in the
dictionary—they're too easy to guess.
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Figure 10.17 Verify and change your Apple ID settings
in the Edit Account dialog.

& Briure Conmctian

Edit Shipping Addresses :
Vi (2N 2awe musticke BOUTEILES 80 MSLE It eLNer 10 AIVe DIEEE JEEVENED T0 pou, Your frends.
e larmity,

Addiess: | Add New Address..

Labell  New Address

Coimiiy; {1ed uaee ]

Title: | Mr. -l
Firkt Name: | Last Nama:
Address:
el 00000 ] State:
Tip Code: fhone:

) Make this my default address

{ Detete This Adgress )

@ e ) (o6 )

Figure 10.18 To enter a new shipping address, choose
Add New Address from the Address pop-up menu,
and then enter the new address in the Edit Shipping
Addresses dialog.

Forgotten Passwords

If you forget your password, enter your
email address in the Apple ID field in the
Apple Account Sign-in dialog, click the
Forgot Password? button, and go through
the necessary Web pages. Apple sends
you an email message containing your
password.

Using Your Apple ID

Once you have your Apple ID set up, you can
use it with Apple’s ordering services. It’s also
useful for some of Apple’s online tech sup-
port services and ordering from the iTunes
Store or Apple Store. iPhoto usually remem-
bers your Apple ID, but if not, you can always
sign in manually.

To sign in using your Apple ID:

1. Inone of iPhoto’s Order windows (for
prints, books, cards, or calendars), click
either the Account Info button or the Set
Up Account button to display the Apple
Account Sign-in dialog (Figure 10.15 on
the previous page).

2. Enter your Apple ID and password, and
then click the Sign In button.
iPhoto displays the Edit Account dialog
(Figure 10.17).

3. If 1-Click purchasing is turned off, select
the Enable 1-Click Purchasing checkbox.

4. Verify that everything else looks correct
(if not, click the Edit button next to the
incorrect data and make the necessary
corrections), and then click Done.

v Tips

B You can switch between Apple IDs using
the method above with two sets of email
addresses and passwards. This is handy
if multiple people want to order items on
separate accounts.

B You can add additional shipping
addresses by clicking Edit Shipping in the
Edit Account dialog, choosing Add New
Address from the pop-up menu, and fill-
ing in the details (Figure 10.18). Switch
between the addresses by choosing the
desired one from the Ship To pop-up
menu in an Order window.
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PREPARING TO ORDER PRINTS

Chapter 10

Preparing to Order Prints

Since iPhoto’s snazzy zoom and crop inter-
face isn't available when ordering prints, you
will want to spend some time preparing your
photos for printing by cropping them to the
appropriate aspect ratios for prints. But what
if you don’t want to crop the originals perma-
nently? Follow these steps.

To prepare photos for printing:

Pixels and Prints

You may have noticed that iPhoto reports
how large your photo is in pixels in the
Information pane. But how does that
match up with print sizes that you order
from Apple? You mostly don’t have to
care, since iPhoto displays a low-
resolution warning icon when a photo
doesn’t have enough pixels to print well at
the desired size. For reference, here are the

1. Make a new album, and add the photos pixel sizes at which iPhoto starts adding
that you want to order prints of. the warning icon, given both in terms of
2. Switch to the album, and edit each photo the 4}(' 3 aspect ratio (.)funcrop;?ed photos
as desired, other than cropping. a.nd with t.he appropriate cropping for the
size at which you want to print.
3. Inorganize mode, select all the photos o
(©md(A)) and choose Duplicate from the Note that these arelthe minimum rec-
Photos menu ([Cma)D)) to make copies ommended resolutions. The larger your
(for details, see “Duplicating Photos,” on 15 h'otfos and the more they exceed th'ese
page 85). minimums, the better the final quality.
4, Select just the copies in your album e wallef—smesl prints (which are
("Duplicating Photos” explains this too). about 2.4 4 3.47), you need at least
337 x 450 pixels (when cropped to the
5. Dragthem to the source pane to create above aspect ratio, keep the long side
anew album of just the copies (append above 450 pixels).
the word “Prints” to its name to be clear), o
and then return to the previous album e 4_ X 6" print, you need at least 675
and delete it (or keep it, if you have some x 900 pixels (when CIIOPPEd fe
other use for it). 4 x 6, keep the long side above 900
pixels).
6. Go through the photos in the “Prints” Vo
album, this time cropping each to the ¢ Forab'x 7" print, you need at least 788
desired aspect ratio. x 1050 (when cropped to 5 x 7, keep
the long side above 1050 pixels).
7. Ifyou're printing photos in different . _
sizes, manually group them by size in the ¢ Foran8'x 10 print, you need at least
album. That makes keeping track of them 1200x 1600 (Wh?n cropped to 8 % 10,
I o M keep the short side above 1200 pixels).
Now you're ready to order the prints (see * For 16" x 20" prints, you need at least
the next page). 1600 x 2132 (when cropped to 16 x 20,
keep the short side above 1600 pixels).
# For 20" x 30" prints, you need at least
1800 x 2400 (when cropped to 20 x 30,
keep the long side above 2400 pixels).
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Figure 10.19 To order prints, select one or more pho-
tos, click the Order Prints button, and in the Order
Prints dialog, enter the number of prints of each
photo that you want. When you're ready, click the
Buy Now button.

International Shipping Details

Apple currently supports print, book,
card, and calendar orders in the United
States, Canada, Japan, Europe, Australia,
New Zealand, Singapore, and Hong Kong.

However, you can send orders only to
addresses within your shipping region. So
if you live in the United States and wish
to send a calendar to a friend in Scotland,
you must first ship it to yourself and later
mail it to your friend.

Ordering Prints

Once you've prepared your photos, it’s time
to order prints.

To order prints:

1.

v Tips

Make sure you're connected to the
Internet, select one or more photos,
and click the Order Prints button.
iPhoto opens the Order Prints dialog
(Figure 10.19).

For each picture, enter the number of
each size print you'd like to order.
iPhoto automatically updates the total
cost as you add and subtract prints.

Choose the appropriate shipping address
and method from the Ship To and Ship
Via pop-up menus.

Check your order carefully to make sure
you're getting the right number of each
print, and confirm that each photo can
print at the size you've selected.

Click the Buy Now button.

iPhoto uploads your pictures and alerts
you when it's done.

If the Order Prints button isn’t show-
ing, choose Order Prints from the View
menu’s Show in Toolbar submenu.

Uploading takes a long time on a slow
Internet connection because iPhoto
uploads full-size images for best quality.

SLINI)jd 9NIb3qAQ

If you want mostly 4" x 6" prints, click the
Quick Order 4 x 6's arrows at the top
right to increase or decrease the number
of 4" x 6" prints of each photo.

If you see a yellow warning icon next to a
size you want, see “Dealing with Warning
Icons,” on page 198.
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Chapter 10

Creating Cards Overview

Of cards, books, and calendars, cards are the
easiest to create, since they have room for
only a few photos and minimal text.

To create a card:

1.

Select the photo or photos that you want
to appear on your card.

Click the Card button in the toolbar.

In the card design dialog, choose Greeting
Card or Postcard from the pop-up menu
at the upper left, select a theme, and click
Choose (Figure 10.20).

iPhoto creates your card (Figure 10.21).

For the front of the card, choose the
desired background, orientation, and
design from the Background, Orientation,
and Design pop-up menus, and add and
format text as desired (see pages 178-183
for instructions on different ways to work
with text).

When you're done, click the Buy Card
button, and run through the process of
ordering your card. See “Ordering Cards,
Calendars, and Books,” on page 185.

v Tips

If you're not sure which of several photos
you might want to use, or if you're work-
ing with a theme with multiple photo
frames, select several photos before creat-
ing the card, and drag different photos
into the photo frame(s) to see how they
look.

Greeting cards are 5" x 7" with a picture
on the outside and text on the inside;
postcards are 4" x 6" with a picture on
the front and room for text or text and
an address on the back.

For tips on editing photos in a card, see
“Editing Photos on Pages,” on page 176.
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Figure 10.20 Choose your desired card type from the
pop-up menu and pick a theme from the scrolling list
of themes.
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Figure 10.21 iPhoto creates the card in the Keepsakes
list of the source pane, showing the front and inside
of the card in the display pane.
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Figure 10.22 Choose a design from the Design pop-up
menu to change the look of your card.
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Figure 10.23 Choose a color from the Background
pop-up menu to change the color of your card.

Designing Your Card

iPhoto provides only a few ways you can
change the design of your card.

To design a card:
1. Select the front of your card by clicking it.

2. From the Orientation pop-up menu,
choose either Horizontal or Vertical.

3. From the Design pop-up menu, choose
adesign (Figure 10.22). Repeat until
you've found the design you like.

4. Select the back/inside of your card by
clicking it in the display pane.

5. From the Design pop-up menu, choose a
design. Repeat as necessary until you've
found the design you like.

6. Ifyou don’t like any of the designs, click
the Themes button and choose a new
theme from the card design dialog.

7. From the Background pop-up menu,
choose a complementary background
color (Figure 10.23).

8. Enter text in the provided text boxes
and, if you don't like the default text
format, reformat it as desired.

v Tips

B [ recommend sticking with the fonts that
Apple’s designers chose. Otherwise, you
risk picking a font that may not look as
you expect on the finished card.

ay¥v) INOA ONINDISIQ

B You can enter text only in the provided
text boxes. Different themes may offer
additional places to enter text, but in gen-
eral, text options are limited with cards.

m With postcards. the back of the card can
accept either a design that provides room
for general text or a design that provides
space for an address and a stamp.
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Chapter 10

Creating
Calendars Overview

Calendars are a bit more involved to create
than cards, though less so than books. Here's
the basic process:

To create a calendar:

1. Select the photos that you want to appear
in your calendar.

2. Click the Calendar button in the toolbar.

3. In the calendar design dialog, select a
theme from the list of themes, and click
Choose (Figure 10.24).

4. iPhoto then displays the calendar options
dialog; set the options for when to start
the calendar, how many months it should
contain, and what holidays and calendar
events should be included on it automati-
cally (Figure 10.25).

iPhoto creates your calendar in the
Keepsakes list in the source pane
(Figure 10.26).

5. For each calendar page, set the number of
photos and the design using the Layout
pop-up menu. Drag photos from the ver-
tical photo list to frames in the calendar
page or to particular dates in a month.
You can drag photos from frame to frame
or date to date to move them around, or
off the page entirely to put them back in
the available photo list.

6. When you're done, click the Buy Calendar
button and run through ordering your
calendar. See “"Ordering Cards, Calendars,
and Books,” on page 185.

v Tip

® To save time placing photos, arrange the
photos in an album before selecting the
album and creating the calendar.

m Picture Calendar .
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Figure 10.24 Select a theme from the scrolling list of
themes and click the Choose button.
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Figure 10.25 Set the options for your calendar.
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Figure 10.26 iPhoto creates the calendar in the
Keepsakes list, showing the cover in the display pane,
with the available photos to the left.

Changing Start Dates

Unfortunately, when you change the

start date of a calendar (as you might, if
you want to give the same calendar as a
mid-year anniversary present and an end-
of-year holiday gift), iPhoto removes all
photos you've added to individual dates,
forcing you to replace them manually.
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Figure 10.27 Use the buttons above the vertical list
to switch between showing calendar pages and avail-
able photos (showing above). Use the buttons below
the list to switch between showing both calendar
pages (top and bottom, showing above) and just the
top or the bottom page in the display pane.

Drag to reposi-
tion the photo.

Drag to zoom in
on the photo.

Select to include
acaption.

Enter your cap-
tion here.

Click to select the
caption location.

Figure 10.28 Double-click a photo on a date to zoom
in, reposition it within the square, add a caption, and
position the caption location.

22

Earth Day

Enter custom text
fora particular —___

date under the B
date number.

Figure 10.29 Click a date to open a window in which
you can enter custom text. You can apply font styles
and colors to the custom text, but not to the date
number.

Designing Calendar Pages

Depending on the theme you select, there
may be quite a few design options for indi-
vidual calendar pages. Follow these steps:

To design a calendar page:

1. Select a page by clicking it in the display
pane or in the vertical list (Figure 10.27).

2. From the Layout pop-up menu, choose
a page type, which generally involves the
number of photos on the top page.

3. Ifyou don’tlike any of the page types,
click the Themes button and choose a
new theme.

4, Drag photos from the available photo
list to photo frames on the top page or
to individual dates on the bottom page.
Move or delete photos as desired. Photos
can appear more than once.

5. Double-click photos to zoom and posi-
tion them, and. for those on dates, to add
captions (Figure 10.28).

6. Enter text in any provided text boxes, and
add text to individual dates by clicking
a date and typing the text in the date
window (Figure 10.29).

v Tips

B When viewing calendar pages in the ver-
tical list, you can click the top or bottom
page of the thumbnail to select it (use
the controls explained in Figure 10.27),
which helps when choosing page designs.

m Some themes offer independent designs
for the top and bottom pages; others
apply the design to both pages at once.

m Captions can appear only in cells adja-
cent to their pictures.

m For tips on editing photos, see “Editing
Photos on Pages.” on page 176.
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CREATING BOOKS OVERVIEW

Chapter 10

Creating Books Overview

Because books offer the most flexibility,
they require the most effort to create. But
fear not; iPhoto still makes the process far
simpler than laying it out by hand would
be. Here's my recommended process:

To create a book:

1. Make a normal album with the photos
you want in your book (see “Creating
Albums,” on page 39 and "Adding Photos
to Sources,” on page 46). You can drag
more photos to the book later if you
forget any.

2. Arrange the photos in the album in the
rough order you want them to appear
in the book (see “Sorting Photos,” on
page 48). Make sure no photos are
selected when you're done.

3. Click the Book button in the toolbar (if
the window is narrow, choose Book from
the Keepsakes pop-up menu instead).

4. Inthe book design dialog, choose a book
size from the Book Type pop-up menu
and select a theme. The dialog shows
a preview of each book size and theme

(Figure 10.30).

iPhoto creates your book in the
Keepsakes list in the source pane

(Figure 10.31).

5. For each book page, set the number of
photos and the design using the Layout
pop-up menu, and add text as desired.
You can drag photos from frame to frame
to move them around or off the page
entirely to put them back in the available
photo list.

6. When you're done, click the Buy Book
button, and run through the process of
ordering your book. See “Ordering Cards,
Calendars, and Books,” on page 185.
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Figure 10.30 Choose your desired book type from the
Book Type pop-up menu, and pick a theme from the
scrolling list of themes.

Figure 10.31 iPhoto creates the book in the
Keepsakes list, showing the cover in the display
pane, with available photos and pages above.

Avoid Autoflow!

Should you let iPhoto lay out your book
automatically by clicking the Autoflow
button? Only if you're short on time and
want a quick result. It’s much harder to
rearrange photos on pre-built pages (so
use automatic layout only if your photos
are already in the correct order). Also,
iPhoto can’t guess how many related
photaos you've given it or which photos are
likely to look good together in a two-page
spread, so expect to spend time fixing

every page.
There’s no harm in trying an automatic
layout, but if you don’t like it, delete the

book and start over, rather than trying to
fix each page. I never use Autoflow.
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Figure 10.32 Choose the number of photos you want
to appear on the page from the Layout pop-up menu.
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Figure 10.33 Choose a background color from the
Background pop-up menu.

v/ More Tips

B After the cover page (and inside flap, for
hardcover books), which is required, the
other page designs are optional.

B [fan entire page is gray in the Layout
pop-up menu, the page contains a back-
ground photo, with text and other photos
optionally on top. You can set opacity by
clicking the photo and using the opacity
slider under the zoom slider.

B Many of the page designs assume an
aspect ratio of 4 x 3, so if you use a non-
standard cropping ratio, photos may not
line up as you expect. A different page
design or photo arrangement might help,
or you may have to zoom in on the photo
and reposition it within the frame.

Designing Book Pages

If you choose to lay out your photos on pages
manually (and you should), you need to
make a number of choices about how each
page will look.

To design a page:
1. Select a page by clicking it.

2. From the Layout pop-up menu, choose a
design, which usually involves the num-
ber of photos you want to appear on the
page (Figure 10.32).
iPhoto changes the design of the selected
page, pushing already placed photos up to
the available photo list if you reduced the
number of available photo frames.

3. Add, remove, or rearrange photos within
the available frames.

4. From the Background pop-up menu,
choose a color (Figure 10.33).

5. Repeat steps 2—4 until you have the page
looking exactly as you want.

v Tips

m Each theme offers a new map page
design, and the Travel theme has numer-
ous map designs. For more detail, see
“Putting Maps in Books,” on page 78.

B Each theme offers different page design
possibilities. Spend some time looking at
each one to get a feel for which you like
the most. For an extremely detailed look
at each theme’s page designs, check out
Liz Castro's iPhoto Book Themes site at
www.lizcastro.com/iphotobookthemes/.

B Images can appear multiple times: a
white checkmark indicates if an image
has been used already.

B The more photos in a page design, the
smaller they appear on the page.
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ADDING, DELETING, AND MOVING BOOK PAGES

Chapter 10

Adding, Deleting,
and Moving Book Pages

No matter how many photos you use to cre-
ate a book, iPhoto creates the book with 20
blank pages. You should fill up those pages,
since you'll pay for blanks, but what if you
need more, or what if you find yourself with
extras at the end?

To add a page or page spread:

¢ Click the Add Page(s) button or choose
Add Page from the Edit menu.
iPhoto adds either one page, if you're
viewing a single page at a time, or a
two-page spread, if you're viewing page
spreads, to the right of the currently
selected page or spread (Figure 10.34).

To delete a page:

¢ While viewing pages (not available
photos) in the scrolling list, select a page,
choose Remove Page from the Edit menu
or press (Delete]). Click Delete if iPhoto asks
if you want to delete the page.

To move a page or page spread:

¢ While viewing pages (not available
photos) in the scrolling list, drag a page or
page spread (it depends on your current
view) from one position in the scrolling
list to another position (Figure 10.35).
iPhoto rearranges the pages in the book
to match.

v Tip

B Remember that you can choose Undo
((€md)2)) from the Edit menu if you add
or delete pages by mistake.

Click to view —
book pages.

Click to view ——
available photos.

Press Deleteto — |
remove the page.

Click to add a

page or page \
spread.

Click to view indi-
vidual pages.

Click to view
page spread \ =

SENE S

Unrset  ASt Fagen  Actafee)

Figure 10.34 Use the controls in book mode to set
whether you're seeing pages or available photos

in the scrolling list, to set whether pages appear
alone or as two-page spreads, and to add new pages.

Figure 10.35 To rearrange pages, drag them from
position to position in the scrolling list.

Arrangement Tips

Think carefully about the best arrange-
ment of photos and pages in your book.

A chronological layout may work well for
vacation photos, whereas mixing shots of
people might make more sense for party
photos.

For the best layouts, pay attention to the
photos that will appear on the same page
to make sure they overlap appropriately
and have compatible colors. Also consider
not just one page at a time but the entire
two-page spread, and think about the
direction people are facing when placing
multiple photos on a page. ((Control]-click a
photo and choose Mirror Image to make
people face the opposite direction.)

Note that page designs can change when
you swap landscape and portrait photos.
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Figure 10.36 To add a photo to a page, creating a new
frame in the process, drag a photo to a blank portion
of the page, as I'm doing on the right-hand page.

Figure 10.37 To add a photo to an existing frame, drag
it to the destination frame, as I’'m doing to the lower
left corner frame in this calendar page.

Arranging Photos on

Book and Calendar Pages

As you design pages in books and calendars,
you must arrange photos so they appear in

the right order.
To arrange photos on pages:

¢ To change the number of photo frames

on a page, choose a different page type
from the Layout pop-up menu.

If the new page type has fewer frames,
iPhoto pushes already placed photos back
into the available photo list.

To add a photo to a page manually,
increasing the number of photo frames
on the page, drag it from the available
photo list or from another page to a blank
portion of the page (Figure 10.36).

To remove a photo from a photo frame,
drag the photo from the frame to the area
outside the page, or to the available photo
list.

iPhoto removes the photo from the frame,
putting it either at the beginning of the
available photo list or where you dropped
it. The frame may or may not disappear,
depending on the number of remaining
frames.

To add a photo to a frame, drag it either
from the available photo list or from
another visible frame, to the desired
frame (Figure 10.37).

If the destination frame is empty, iPhoto
assigns the photo to that frame. If the
destination frame is already occupied,
iPhoto swaps the two photos.

To change how a photo overlaps with
an adjacent photo, [Control]-click it and
choose Move to Front or Send to Back
from the contextual menu that appears.
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Chapter 10

Editing Photos on Pages

While you're laying out and arranging photos
in cards, books, and calendars, you may
discover that a particular photo would look
better if it were cropped more heavily or
otherwise edited. You can easily make non-
permanent crops (zooming into a photo)

or switch to edit mode for other changes.

To zoom and center photos:

1. Select a photo to reveal the zoom slider
above the image (Figure 10.38).

2. Drag the slider to the right to zoom into
the image, essentially cropping it further
without actually changing the original.

3. Drag the image itself within the frame to
center the photo. If you haven't already
zoomed in, click the hand button first (to
make it gray) to move a portrait photo in
a landscape frame.

4. Click anywhere outside the photo when
you're done.

To edit photos:

1. Double-click a photo, or (Control)-click it
and choose Edit Photo from the contex-
tual menu that appears (Figure 10.39).

2. Make your changes, and when you're
done, either click the Done button or
double-click the photo to return.

v Tips

B In certain cases, you may need to
re-center photos within their frames
even if you haven't zoomed; certain page
designs cut off the edges of photos.

W Tofit a photo within its frame (after
you've zoomed, or if it’s wrong to start
with), (Control}-click it and choose Fit
Photo to Frame Size from the contextual
menu that appears.

1

Figure 10.38 To zoom into a photo, click it (double-
click in calendar dates), drag the zoom slider to the
right, and then drag the photo around to re-center
it, as I've done in the large picture on the right-hand
page above. Since it's a background photo, I've also
decreased its opacity; only background images get
the opacity slider.

Figure 10.39 To make other editing changes, either
double-click the photo or Control-click it and choose
Edit Photo. When you're finished, click the Done but-
ton to return to the book, card, or calendar that you're
creating.

Zooming Is Cool!

I adore iPhoto’s zooming and center-

ing capabilities, since many photos look
better in print, card, book, and calendar
layouts when they're zoomed further
than they were cropped initially. Although
zooming acts like cropping, and may
cause a yellow warning icon to appear

if there isn’t enough data in the zoomed
portion to print well, it’s entirely non-
destructive and doesn't affect the original
photo.
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Figure 10.40 When a page design calls for a photo
to be printed larger than its resolution allows, iPhoto
places a warning icon on the offending image.
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Figure 10.41 To make the warning icon disappear,
change the page design so the printed size better
matches the resolution of the image. In this example,
adding more photos decreased the size of each photo
to the point where at least some of them would print
at a decent quality (these are 640 x 480 photos from
an Apple QuickTake 150 from 1996).

Text Warning Icons

If you see a small, yellow, triangular
warning icon next to a text box while
designing pages (Figure 10.41), it's
because the text doesn’t fit in the box. The
font size is predetermined by the theme,
but you can switch to a different font or
shorten the text.

Dealing with
Warning Icons

One problem that can appear any time you
print a digital photo is poor quality, or rather,
your inability to predict the quality of a

print. Numerous variables can play a part in
reducing the quality of a printed image, but
iPhoto tries to help prevent one of the most
common—printing an image at a size larger
than is appropriate for the image's resolution.
When you have an image that’s too low reso-
lution for the proposed size, iPhoto displays
a triangular warning icon to alert you to the
problem (Figure 10.40).

Ways to deal with a low-
resolution warning icon:

¢ Choose a different page design so the
photo with the warning icon shrinks
small enough that the icon disappears
(Figure 10.41).

+ Move the image to a different location
on the current page or another page
where it will appear at the necessary
smaller size.

¢ Cropping a photo or zooming it makes
it more likely that the image won'’t be
large enough to print properly. To remove
cropping, select the image, and from the
Photos menu choose Revert to Original.
Remember that this will remove all your
changes, not just the cropping. Try again
after cropping the image less heavily.

¢ Ifyou run into this problem regularly,
make sure your camera is set to take
pictures at its highest resolution.

¢ Ifyou decide to live with a low-resolution
warning icon, note that the icon won't
appear on the printed page.
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ENTERING AND EDITING TEXT

Chapter 10

Entering and Editing Text

Once you have laid out all your pages to your
satisfaction, you can enter or edit the text
that appears with the photos.

Ways to enter or edit text:

¢ C(lick a text box and either enter new Q
text or edit the existing text. While :
you're editing, iPhoto displays a
selection rectangle around the text a0 B Iy & & N W Lpame | = m
box (Figure 10.42).
Figure 10.42 To edit or enter text, click a text box and
¢ Youcanuse all the standard edjtjng enter new text or edit the existing text. If there is too
techniques and commands that you've much text in the text pax, awarning icon appears to
alert you when you click out of the box. No scroll bars
become accustomed to as a Mac user— will appear; you must edit the extra text blindly.
commands like Cut, Copy, and Paste, not
to mention double- and triple-clicking, ; HE. lj ]-- -—E ; m |
¢ You can check the spelling of your text. ———— -
See “Checking Spelling as You Type,” on
page 183. San Francisco to Seattle Car Trip, April 2006
V Tips e all atumed when Tora b & hrainsiem during the sk davs afer (hriamas “Vabe we mould
T e
B Ifyou leave iPhoto’s placeholder text b o eyt i ot b e S, Lo, K, g St
eyl sl varios addue friends, sevl diem s warek susr way uji the cot s Seane Alag the way e
alone, those text boxes won't appear in e T Pt I e e Se o
the final book. Photos don’t take over the
empty space; it just prints blank.
B iPhoto can pick up existing album names, . . ]
€] ad s terbaalesit Figure 10.43 It’s helpful to zoom in using the size
titles, and descriptions for books 1 slider so you can see what you're typing.
Automatically Enter Photo Information is
selected in the settings dialog.
m iPhoto no longer tries to simplify editing
by zooming in on the page in the display
pane so the text displays larger. Now you
must zoom in manually, using the size
slider in the display pane (Figure 10.43).
B Ifyou copy and paste text, the font-
related information of the copied text
accompanies the pasted text, which may
not be desirable.
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Smart Quotes, Easily

In Mac OS X 10.5 Leopard, Apple has
added a Smart Quotes feature that auto-
matically turns single and double hash
marks into true apostrophes and quota-
tion marks. To turn it on, [Control]-click
any text block and from the Substitutions
submenu, choose Smart Quotes so it gets
a checkmark next to it.

The Wrong Way

Here it's a cold afternoon in March. Mary
is gazing out over the GRAND CANYON
at sunset--check out the sweater
Grandma Bunny actually knitted

for her. The other folks in this picture
are:

* My friend Samuel from work.

* Mary's cousin JoAnn.

* JoAnn's husband, who goes by "Chuck”.
Copyright (c) 2009 Joe Schmoe

The Right Way

Here it's a cold afternoon in March. Mary
is gazing out over the Grand Canyon at
sunset—check out the sweater Grandma
Bunny actually knitted for her. The other
folks in this picture are:

» My friend Samuel from work.

» Mary’s cousin JoAnn.

- JoAnn’s husband, who goes by “Chuck.”
Copyright © 2009 Joe Schmoe

Typing Text “Correctly”

You're going to zoom into your photos
perfectly and arrange them just so—are you
then going to write text that looks downright
trashy? Follow a few simple rules to make
sure your text looks as good as your pictures
and iPhoto layouts (if you don't believe me,
compare the example captions to the left).
For details, snag a copy of Robin Williams’s
classic book The Mac is not a typewriter.

Rules for classy looking text:

¢ DPut only one space after periods,
commas, question marks, parentheses,
or any other punctuation.

»

¢ Use true quotation marks (* ") instead
of double hash marks (""). To get them,

type (Option]([) and (Option) Shift]([].
¢ Use true apostrophes (") instead of hash

marks (). To get them, type and
(Option](Shift) 1)-

¢ Punctuation goes inside quotes.

¢ Instead of double hyphens (--), use an
em dash (—). Press [Option][Shift) - ).

¢ Ifyou want to put a copyright symbol
(©) in your book instead of (c), get it by
typing (Gptin] G

¢ Tomake alist, use bullets (+) rather
than asterisks (*). To type a bullet, press

(Option)(8).

¢ Intext boxes that have relatively long
lines of text, edit to prevent the last line
from containing only a single word.

¢ Avoid underlining text. Instead, use ital-
ics, which may require that you select an
italic version of the font you're using.

¢ Use uppercase sparingly, and only in
titles. Uppercase text is hard to read.
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